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Introduction

This section provides information that you should know 
before reading the User’s Guide for the ELC-MVS01 Live 
Production Control Software.  

Configuration of This Guide

The User’s Guide explains how to set up and operate the 
ELC-MVS01 software. It is composed of the following 
groups: 

Overview 
Chapter 1 explains the basic concepts of the ELC-MVS01 
software, its four component applications, system 
configurations, and workflow. 
Chapter 2 explains the names and functions of each part in 
the five major windows of the ELC-MVS01 software:  
Initial Setup, Icon Manager, ELC Plug-in, Playlist Viewer, 
and OA Playlist. 

Preparations
The Chapters from 3 to 5 explain preparations and setup 
that mainly technical directors or system integrator should 
be responsible for before making news programs: making 
the initial setup with the Initial Setup application, creating 
Icons with the Icon Manager, and making cues in the ELC 
Plug-in application.  If necessary, ELC operators can refer 
to and change required settings.
Chapter 6 provides required preparations that technical 
directors should be responsible for when they use 
advanced functions of the software: switching multiple 
snapshots and videos manually.

Operations 
Chapters 7 and 8 instruct ELC operators on how to create 
a playlist based on a rundown they had created on NRCS 
(ELC Plug-in/Playlist Viewer applications). These 
Chapters also explain a series of procedures to play out the 
created playlist with the OA Playlist application. 
Chapter 9 explains how to execute the settings performed 
in Chapter 6; how to recall multiple snapshots such as 
2Box effects manually, and switch video manually 
(Manual Switching).

Appendix
The section consists of glossary and index.

Notational Conventions

• The plus sign (+) is used to indicate that two keys on the 
keyboard should be pressed at the same time. For 
example, Ctrl + C means to press the C key while 
holding the Ctrl key down.

• Square brackets ([  ]) are used to indicate a menu that 
should be used or button command that should be 
clicked to perform an intended operation.

• The greater than sign (>) is used to indicate that a menu 
subcommand is located below another menu command.
For example, [Tools] > [Plug-in] means that the [Plug-
in] command is a subcommand of the [Tools] command.

Notice for the pictures on this guide
The pictures used in this guide may be different from the 
ones actually displayed and are subject to change without 
notice.



Overview
This section explains the basic concepts of the ELC-MVS01 
software, its component applications, system configurations, 
workflows, and elements of a playlist.  It also explains the names and 
functions of each part in the major windows of the ELC-MVS01 
software:  Initial Setup, Icon Manager, ELC Plug-in, Playlist Viewer, 
and OA Playlist. 

Chapter 1   Overview......................................................................... 9

Chapter 2   Names and Functions of Parts.................................... 18
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Features

The ELC-MVS01 Live Production Control Software 
provides an automation solution for the News Room 
Computer System (hereinafter referred to as “NRCS” in 
this manual), taking full advantage of the unprecedented 
high performance and multifunctionality of the Sony 
MVS-8000 Multi Format Switcher system. The following 
are some of the principal features of this software.

NRCS Centric
The ELC-MVS01, when incorporated into an existing 
NRCS-centric broadcast system, allows you to utilize the 
existing workflows to create programs. It automates 
control over devices which used to be manually controlled 
by a specialized operator. 

Complex device control taking advantage of the  
Sony MVS-8000 network
Coupled with an MVS-8000 system, the ELC-MVS01 
automates control over robotic cameras, audio mixer, disk 
recorder, audio servers, playout server, or any other MVS-
8000 system components.

Enhanced flexibility with manual operations
In addition to its versatile automation features, the ELC-
MVS01 also provides flexible manual on-air operations, 
including adjustment of audio levels, or inserting or 
deleting the DSK.

Real-time synchronization and update of playlists
If NRCS rundown changes occur, real-time 
synchronization updates the ELC-MVS01 playlist 
(referred to as “ELC playlist” in this manual), so that you 
can cope with last minute modifications.

An easy-to-use graphic user interface 
The ELC-MVS01 software offers an easy-to-use graphic 
user interface which navigates you through a series of 
program creation procedures: allocating frequently-used 
settings to an icon, using icons to create a cue, using cues 
to create a playlist, and finally playing out a playlist, all in 
integrated, simple-to-operate operation windows.

ELC-MVS01 Software 
Products

The ELC-MVS01 Live Production Control Software 
system consists of the following software components, 
products, and optional software products.

Software Components Products

The ELC-MVS01 Live Production Control Software 
consists of the following applications:

• ELC Plug-in (including a 5-user licence)
This application allows you to register frequently-used 
scenes as a “cue” (Quick Cue), and set or edit a cue (Cue 
Edit). It also allows you to create a playlist.
(The software works as a plug-in to the NRCS client 
software.)

• ELC Playlist Viewer (including a 5-user licence)
This application allows you to view created playlists.
(The software works as an independent application.)

• Icon Manager 
This application is used to associate frequently-used 
device settings with Video, Audio, Transition, and 
Effect Icons for easily creating playlists.

• ELC OA Playlist
This application is used to play out created playlists. 

• Initial Setup
This application is used to set up the system 
occasionally, for example, when a new news program is 
planned.

• System Setup
This application is used to set up the system for system 
integration purposes. To use this application, access to 
9Features
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the Sony web site for the system setup.  
For details, contact your Sony service representative.

Optional Software Products 

As an optional software product, the ELC-MVS01 Live 
Production Control Software offers the following:

• BZEL-MVS11 Sony Redundant Control 
Software
This product is used to configure a redundant system for 
ELC-MVS01. Using this software to configure two PCs, 
one as the main PC, and one as the backup, allows you 
to continue working, even if the main PC experiences a 
problem. Switchover is accomplished by means of a 
simple operation.

• BZEL-MVS21 Sony NRCS Plug-in Software
This product contains an additional 5-user licenses for 
the ELC Plug-in application and the Playlist Viewer. 
These are floating licenses. 

• BZEL-MVS41 Sony Audio Mixer I/F Software
This product aims to control an audio mixer from the 
ELC-MVS01.

• BZEL-MVS51 Sony Camera Robotics I/F 
Software
This product aims to control robotic cameras from the 
ELC-MVS01.
ELC-MVS01 Software Products
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System Configurations

Basic System Configuration

The ELC-MVS01 Live Production Control Software 
supports flexible NRCS-centric system configurations 
with an MVS-8000 system, audio mixer, robotic camera, 
audio server, playout server, CG and other devices. 

The following illustration shows an example image of the  
basic system configuration with the NRCS.

Equipment to be Used in the System 

This section explains major devices to be used with the 
ELC-MVS01 Live Production Control Software system: 

Devices required for ELC-MVS01 control 
(Shown on a gray background  in the 
system configuration diagram)
• Shot Box Module

The shot box module is used for allocating a variety of 
manual operations to its 96 operation buttons. This 
module is required when you forward an ELC playlist 
with the TAKE button, or inserting or deleting the DSK. 
Up to two modules can be connected, although the 
functions to be associated are the same.

• Audio Fader Panel
The audio fader panel allows you to associate a total of 
16 audio mixer channels with its 8 faders, and to adjust 
audio levels, change PFL(Cue) and MIX- settings, and 
turn the channels on and off.
Its front 8 faders automatically change their assignment 
settings and adjust audio levels according to the process 
in a playlist. For the back 8 faders, the assignments are 
fixed and audio levels should be adjusted manually.

Devices under ELC-MVS01’s control
(Connected with black dash-dot lines in 
the system configuration diagram)
The following devices perform on-air operations 
according to the ELC playlist under the ELC-MVS01’s 
control:
11System Configurations
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• Video Switcher
The switcher uses an M/E for OA video effects and 
another M/E for NEXT video effects, and uses PGM/
PST to switch OA and NEXT video signals.
It controls Keys automatically according to the ELC-
MVS01’s settings, and controls the DSK manually. The 
ELC-MVS01 does not make the DSK settings, but it 
uses the settings (Initial Snapshot) automatically loaded 
when the OA Playlist application is started.

• DDR (VDCP)
The DDR (VDCP) is a disk recorder that the ELC-
MVS01 can control with VDCP (Video Disk Control 
Protocol). You should register and list necessary video 
files to be used in the ELC-MVS01 in advance by using 
the Initial Setup application. 

• DDR (SonyVTR)
The DDR (SonyVTR) is a disk recorder that the ELC-
MVS01 can control with Sony VTR Protocol. You can 
use the desired video materials in the recorder by 
specifying the IN point.

• Audio Server
You should register and list necessary audio files to be 
used in the ELC-MVS01 in advance by using the Initial 
Setup application. While preparing a cue, you can 
specify the file names in the list.

• Robotic Camera
The ELC-MVS01 recalls the shots of the robotic camera. 
Since manual control from the ELC-MVS01 is not 
available, the controllers supplied with the robotic 
camera system is to be used.

• Audio Mixer
The ELC-MVS01 controls the audio levels, Ch On/Off, 
changes in MIX- settings, and the function of the audio 
mixer, automatically. Use of the audio fader panel 
enables manual control of audio channels for 16 faders.
Depending on the type of input signals, there are two 
types of audio mixers: 
- Stereo fader mixer: handles stereo signals for each 

input channel fader. This type of mixer is referred to as 
a “stereo fader mixer” in this manual. 

- Mono fader mixer: handles monaural signals for each 
input channel fader. This type of mixer is referred to as 
a “mono fader mixer” in this manual.

 Devices beyond ELC-MVS01’s control 
(Connected with black solid lines in the 
system configuration diagram)
The following devices usually interface to NRCS and get 
Rundown. They have their own playlist creation functions. 
A change in the NRCS rundown is directly reflected, while 
changes in the ELC playlist in the OA Playlist application 
will not be reflected and manual changes are required. To 

control manual operation, you need the control panel 
supplied with each device.

• CG (Character Generater)
CG is the server of CG or still images. After receiving   
Off from the Tally of the switcher, it prepares the next 
materials.

• Playout Server
The playout server is an audio and video server that 
contains daily-changing materials. The server receives a 
GPI from the ELC-MVS01, and plays the materials. The 
ELC-MVS01 does not specify files or make channels 
settings, which are specified or made in the NRCS 
system.
System Configurations
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Basic Operation Flow

The following flowchart shows an example of the 
operations when the system is installed.
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• Creating Icons (page 69)

• Creating Categories (page 81)

• Editing Cues (iNEWS:page 126 /ENPS: page 134)

• Creating a Playlist (iNEWS:page 121 /ENPS: page 132 )

• Viewing a Playlist (iNEWS:page 128 /ENPS:  page 136 )
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• Playing out a Playlist (page 138)

• Changing the Playlist Order 
(page 144)

• Superimposing Characters 
(DSK) (page 146 )

• Adjusting Audio Level 
Manually (page 148)

• Switching Video Manually 
(page 154)

• Switching Multiple 
Snapshots Manually 
(page 152)

: Stands for a series of routine operations

: Stands for advanced manual operations               

• Creating Cues (page 93)

• Editing Cues (page 103 )

• Making Initial Setup (page 41)
13Basic Operation Flow
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Overview of Playlist Creation

Playlist Creation Flow

The ELC-MVS01 provides the ELC Plug-in application 
for the NRCS client software to create a playlist, and the 
Playlist Viewer application to view the created playlist. 
The images below show how an ELC operator uses both 
applications to create a rundown and view a playlist in a 
news room.
You can create a playlist easily by adding a cue from the 
Quick Cue of the ELC Plug-in to the NRCS client window 

as an ELC object, which is called “Production cue” for 
iNEWS and “Item” for ENPS.

Whether you use iNEWS or ENPS as an NRCS, the 
windows and playlist creation operations differ. See either 
of the sections below according to your NRCS type.

When using iNEWS

A playlist can be created, viewed, and played out as 
follows: 

For ELC production cue settings, see “Rules in setting 
ELC production cues” on page 123.

ELC Plug-in
(Quick Cue)

iNEWS
ELC Playlist

Cue 
Each icon 
represents a 
cue, i.e., 
frequently-
used scenes.

Location Purpose Operator Operations in the iNEWS window Display in the ELC Playlist Ref.page

News- 
room

Creating 
a news 
program

Producer A Create a rundown (baseline of a program) 
using the iNEWS client. (Conventional 
operation)

. Rundown is created.

b At this time, there are no ELC 
settings made for the rundown.

. Playlist is not created.

ELC 
Operator

B Add a cue in the Quick Cue of the ELC  
Plug-in to the iNEWS rundown as a 
production cue with a drag-and-drop 
operation.

b

D Production cues with the 
same page number make an 
ELC story. Cues appear in a 
playlist.

. Playlist is created.

page 
121

C Assign channels for CG or playout server 
for the iNEWS client. Then save the 
rundown.(Conventional operation)

page 
123

3

Overview of Playlist Creation
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When using ENPS

A playlist can be created, viewed, and played out as 
follows: 

For ELC production cue settings, see “Rules in setting 
ELC items” on page 134.

Control 
Sub 
room

On the 
air

Producer Change the rundown order in the iNEWS 
client. (Conventional operation)

b

Changes in the rundown will be 
reflected.

ELC 
Operator

• Add a production cue or edit cues even 
while on the air (except for the OA Cue).

• Change the channel assigned for the CG or 
playout server for the iNEWS client. 
(Conventional operation)

• Skip stories on the rundown separately on 
the iNEWS client, on each device, or in the 
ELC Plug-in application.(Conventional 
operation)

page 
126
pages 
12, 123

page 12

Location Purpose Operator Operations in the iNEWS window Display in the ELC Playlist Ref.page

ELC Plug-in
(Quick Cue)

ENPS ELC Playlist

Cue 
Each icon 
represents a 
cue, i.e., 
frequently-
used scenes.

Location Purpose Operator Operations in the ENPS window Display in the ELC Playlist Ref.page

News- 
room

Creating 
a news 
program

Producer A Create a rundown (baseline of a program) 
using the ENPS client. (Conventional 
operation)

. Rundown is created.

b At this time, there are no ELC 
settings made for the rundown.

. Playlist is not created.

ELC 
Operator

B Add a cue in the Quick Cue of the ELC  
Plug-in to the ENPS rundown as an Item 
with a drag-and-drop operation.

b

D Items with the same Slug 
make an ELC story. Cues 
appear in a playlist.

. Playlist is created.

page 
132

A Assign channels for CG or playout server 
for the ENPS client. Then save the 
rundown. (Conventional operation)

3

15Overview of Playlist Creation
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Elements of a Playlist

This section explains the elements of a playlist. The 
following shows the relationship between an Icon, a cue, a 
story, and a playlist in the Playlist Viewer application:

 

Icon
An Icon is a graphic representing settings of a video 
switcher, audio mixer, and devices for materials including 
cameras, servers, and CG.  
There are the following four types of Icons:

• Video Icon
A Video Icon represents video materials from the 
camera, playout server, CG, and DDR. 

• Audio Icon
An Audio Icon represents audio materials from an audio 
server, or video server. 

• Transition Icon
A Transition Icon represents a transition setting. 

• Effect Icon
An Effect Icon represents a setting of compound video 
effects. 

Control 
Sub 
room

On the 
air

Producer Changing the rundown order in the ENPS 
client. (Conventional operation)

b

Changes in the rundown will be 
reflected.

ELC 
Operator

• Add an Item or edit cues even while on the air 
(except for the OA Cue).

• Change the channel assigned for the CG or 
playout server for the ENPS client. 
(Conventional operation)

• Skip stories on the rundown separately on 
the ENPS client, on each device, or in the 
ELC Plug-in application.(Conventional 
operation)

page 
134
pages 
12, 134

page 12

Location Purpose Operator Operations in the ENPS window Display in the ELC Playlist Ref.page

ELC Story

Icon

Cue

Playlist 

Slug

Page
Overview of Playlist Creation
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Cue
A cue is composed of Icons and their detailed settings. It is 
the minimum unit, a frequently-used scene, to be taken by 
the TAKE button. You can easily set a cue, registered in 
the Quick Cue window in the ELC Plug-in application, to 
the NRCS rundown. You can edit created cues in the Cue 
Edit window.

ELC Story
An ELC Story definition differs between iNEWS and 
ENPS:
• In iNEWS: A group of cues with the same NRCS Page 

number is defined as an ELC story.
• In ENPS: A group of cues with the same NRCS Slug is 

defined as an ELC story.

Playlist
A playlist is a list of ELC stories placed in the order to be 
played out. 
17Overview of Playlist Creation
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Chapter2Names and Functions of 
Parts 
Initial Setup Window

The Initial Setup application is designed for technical 
directors to make required setup for routine operations 
when a new program is planned or there is a change on a 
device on a studio. 
To open the Initial Setup main menu, double-click the 
Initial Setup icon on the desktop. From the Initial Setup 
Main Menu, you can select the following sub menus:

• Video Switcher Settings:  It allows you to associate 
a V/K pair number of the video switcher with an Icon. 

• Audio Mixer Settings: It allows you to associate the 
input fader number of the audio mixer with an Icon, and 
specifies audio level options of the ELC-MVS01. It also 
associates each fader number of the Audio Fader panel 
with a device icon registered in the ELC-MVS01, so that 

automatic or manual control from the ELC-MVS01 
becomes enabled. 

• Shot Box Module Assign: It allows you to assign  
functions to be used for manual on-air operations to the 
buttons on the shot box module.

• DDR(VDCP) File List Creation: It allows you to 
register the files of DDR(VDCP) to be used in the ELC-
MVS01 software.

• Audio Server File List Creation: It allows you to  
register the files of the audio server to be used  in the 
ELC-MVS01 software.

You can also view the windows of the Initial Setup 
application in the System Setup application.

Initial Setup Main Menu

1 Menu bar

2 Sub menus
Initial Setup Window
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a  Menu bar
The Menu bar provides menus for using the Initial Setup.

• File menu: 
Exit: Exits the Initial Setup menu.

• Help menu: 
Version: Displays the Initial Setup version number.
Help: Displays this User’s Guide.

b Sub menus
Click the desired sub menu line to open the setting window 
for the selected menu option.

For the Initial Setup Application, see “Starting the Initial 
Setup Application” on page 42.

Video Switcher Settings Window

a V/K Pair No. Setup list
Allocate the V/K pair number of switcher to an ELC-
MVS01 Video Icon:

• V/K Pair No.: A fixed number between 1 to 128 is 
displayed, which has been specified by the switcher.

• Source Name:  The source name of the video specified 
by the switcher is displayed in up to 16 alphanumeric 
characters. 

• Class: Select the desired class to narrow down the 
devices to be displayed, since devices are classified into 
classes.

• Device: Select the desired device, which is 
corresponding to a V/K pair number, to be displayed in 
the selected Class.

b Import button
Press this button to import the source name of the video 
signal from the switcher.

c Video Transition Rate Setting block
Select an option for the video transition rate to be 
displayed in the Cue Edit window.

d Key Transition Rate Setting block
Select an option for the key transition rate to be displayed 
in the Cue Edit window.

e Save button
Press this button to save the settings.

f Close button
Press this button to close the Video Switcher Settings 
window.

For the settings on the Video Switcher Settings window, 
see “Making the Video Switcher Settings” on page 44.

1 V/K Pair No. Setup 
list

4 Key Transition Rate 
Setting block

2 Import button

6 Close button

3 Video Transition 
Rate Setting block

5 Save button
19Initial Setup Window



20

  C
hapter 2  N

am
es and F

unctions of P
arts
Audio Mixer Settings Window

Depending on the type of the audio mixer used, either, a 
stereo fader mixer or a mono fader mixer, the contents of 
the window differ.

a Fader No. Setup list
Allocate the input Fader number of the audio mixer to an  
Audio Icon:

• Fader No.: A fader number of an audio mixer panel is 
displayed according to the Device Setup settings of the 
System Setup application.
For a mono fader mixer, the fader number displayed in 
this column may differ from that displayed on the audio 
mixer panel. 

• Source Name:  The source name of the audio input 
specified with the mixer is displayed in up to 8 
alphanumeric characters. 
When a mono fader mixer is being used and the fader is 
paired, the source name for the odd fader number is 
displayed.

• Class: Select the desired class to narrow down the 
devices to be displayed, since devices are classified into 
classes.

• Device: Select the device in the selected Class 
corresponding to the input Fader number. 

• Stereo/Mono*: Displays the Device Setup settings of 
the System Setup application for how the fader is 
controlled, in stereo or monaural:
Stereo: The fader is paired and controlled in stereo.
Mono: The fader is used and controlled monaurally.

• MonoCh*: Displays the channels actually controlled 
according to the Stereo/Mono setting of the Device 
Setup of the System Setup application. 

• Control: Enable or disable automatic or manual fader 
control from the ELC-MVS01 system. (Including 
assignment of an Audio Icon to the audio fader panel.)

* Displayed only when a mono fader mixer is being used.

b Import button
Press this button to import the source name of the input 
audio from the audio mixer.

c Audio Level Setting block
Set the Audio Level options to be displayed in the Cue Edit 
window.

d Fade In/Out Time Setting block
Set the Fade In/Out Time options to be displayed in the 
Cue Edit window.

e Save button
Press this button to save the settings.

f Close button
Press this button to close the Audio Mixer Settings 
window.

4 Fade In/Out Time 
Setting block

6 Close button

5 Save button

1Fader No. Setup 
    list

2 Import button

3 Audio Level Setting 
block
Initial Setup Window
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For the settings on the Audio Mixer Settings window, see 
“Making the Audio Mixer Settings” on page 47.

Shot Box Module Assign Window

a Assign List
The list of functions assignment to buttons on the shot box 
module is displayed.

• BANK 1 to 4 tabs: Select the desired BANK tab 
corresponding to the BANK button on the shot box 
module. 

• No.:  The button number for the selected BANK on the 
shot box module to which the function is assigned. 

• Name: The name of the assigned function, which is 
displayed on the relevant button on the shot box module.  
You can rename it in up to 8 alphanumeric characters by 
double-clicking the relevant column.

• Function: The function assigned on the button is 
displayed.  

b Delete button
Press this button to delete the selected function from the 
Assign List.

c Button Layout
The button layout of the shot box module is displayed, to 
help you identify the location of the button specified in the 
“No.” column of the Assign List.

d CADD button
Press this button to add the selected function of the 
Function List to the Assign List.

e Function List
Select the function that you want to assign to a recall 
button of the shot box module. 

f Save button
Press this button to save the settings.

g Close button
Press this button to close the Shot Box Module Assign  
window.

For the settings on the Shot Box Module Assign window, 
see “Assigning Functions to the Shot Box Module 
Buttons” on page 54.

4 CADD button

7 Close button

6 Save button

5 Function List

1 Assign List

3 Button Layout

2 Delete button
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DDR(VDCP) File List Creation Window

a File List
A list of files added from the DDR(VDCP) which are 
ready for use with the ELC-MVS01 is displayed.
• No.:  Series numbers of the added files.
• File Name: The name, up to 23 alphanumeric 

characters of the file stored the DDR(VDCP).
• Duration: The length of the file stored on the 

DDR(VDCP) in HH:MM:SS:FF.  

b Delete button
Press this button to delete the selected file from the File 
List.

c Device box
Select the desired device for which you would like to 
import information to the Source Library and then create 
the file list. 

d CADD button
Press this button to add the selected file of the Source 
Library to the File List.

e Source Library
The files stored on the DDR(VDCP) are displayed.
• No.:  Series numbers of the files stored in the 

DDR(VDCP).
• File Name: The name, up to 23 alphanumeric 

characters of the file stored on the DDR(VDCP).
• Duration: The length of the file stored on the 

DDR(VDCP) in HH:MM:SS:FF.  
Select the line of the file you want to add to the File List.

f Import button
Press this button to import the File Name and Duration 
information of the files from the DDR(VDCP). 

g Save button
Press this button to save the settings.

h Close button
Press this button to close the DDR(VDCP) File List 
Creation window.

For the settings on the  DDR(VDCP) File List Creation  
window, see “Managing Video Material - Creating the 
DDR(VDCP) File List” on page 59.

1 File List

4 CADD button

2Delete button

8 Close button

6 Import button

7 Save button

5 Source Library

3 Device box
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Audio Server File List Creation Window

a Device box
Select the desired device for which you would like to 
create a file list, so that the files will be displayed both in 
the File List and Source Library. 

b File List
Displays the list of files added from the audio server which 
are ready for use with the ELC-MVS01.
• No.:  Series numbers of the added files.
• File Name: The name, up to 23 alphanumeric 

characters of the file stored on the audio server.
• Duration: The length of the file stored on the audio 

server in HH:MM:SS:FF.  

c Delete button
Press this button to delete the selected file from the File 
List.

d CADD button
Press this button to add the selected file of the Source 
Library to the File List.

e Source Library
The files stored on the audio server are displayed.
• No.:  Series numbers of the files stored in the audio 

server.
• File Name: The name, up to 23 alphanumeric 

characters of the file stored on the audio server.
• Duration: The length of the file stored on the audio 

server in HH:MM:SS:FF.  
Select the line of the file you want to add to the File List.

f Import button
Press this button to import the File Name and Duration 
information of the files from the audio server. 

g Save button
Press this button to save the settings.

h Close button
Press this button to close the Audio Server File List 
Creation window.

For the settings on the Audio Server File List Creation  
window, see “Managing Audio Material - Creating the 
Audio Server File List” on page 62.

2 File List

3Delete button

1 Device box 4 CADD button

8 Close button

6 Import button

7 Save button

5 Source Library
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Icon Manager Window

The Icon Manager application is designed for ELC 
operator create an Icon, symbolizing frequently-used 
settings of a video switcher, audio mixer, or other device, 
so that you can use them to register a cue. There are four 

types of Icons: Video, Audio, Transition, and Effect. The 
created Icons are then saved in the relevant category. 
To open the Icon Manager window, double-click the Icon 
Manager icon on the desktop. 

Icon Manager Main Window

a Menu bar
The Menu bar provides menus for using the Icon Manager:

• File menu: 
Exit: Exits the Icon Manager menu.

• Help menu: 
Version: Displays the Icon Manager version number.
Help: Displays this User’s Guide.

b Icon types tabs
Click the desired tab which stands for an Icon type you can 
register in the ELC-MVS01: Video, Audio, Transition, 
and Effect.

For the overview of Icons handled on the Icon Manager 
Main window, see “Starting the Icon Manager 
Application” on page 68.

2 Icon list

3 Icon 
Library

2 Icon types tabs

1 Category list

1 Menu bar
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1 Category list

a Category list
The system and user-defined categories are listed. Click 
the desired category so that the relevant Icons are 
displayed in the Icon list.

b Create New button
Click this button to display the Category window to create 
a new category.

c  Edit button
Click this button to display the Category window to edit 
the selected category in the category list.

d Delete button
Click this button to delete the selected category in the 
category list.

For details, see “Category Window” on page 32.

For the operations using the Category list, see “Managing 
Categories” on page 81.

2 Icon list

a Icon list
Stores icons you register according to a category from the 
Icon Library. Among the registered Icons, only the Icons 
in the selected category in the Category list are displayed. 

b Delete button
Click this button to delete the selected Icon in the Icon list 
from the category.
 

For the operations on the Icon list, see “Registering an 
Icon in a Category” on page 87.

2 Create New button

1 Category list

3 Edit button

4 Delete button

1 Icon list

2 Delete button
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3 Icon Library

a ADD button
Click this button to add the selected Icon in the Icon 
Library to the Icon list of the selected category.

b Search block
Check the desired check box of either Name or Class, that 
you want to use for searching for Icons. Then click 
[Search] to search for Icons of the selected search option. 
The Icons found are displayed in the Icon Library.

c Delete button
Click this button to delete the selected Icon in the Icon 
Library.

d Edit button
Click this button to display the Audio, Video, Transition, 
or Effect Icon window to edit the selected Icon in the Icon 
Library.

e Create New button
Click this button to display the Audio, Video, Transition, 
or Effect Icon window to create an Icon.

f Icon Library
Stores the icons that you create or locate.
All the icons belonging to the selected Icon type tab are 
displayed.   

For details, see “Video Icon Window” on page 27, “Audio 
Icon Window” on page 28, “Transition Icon Window” on 
page 29, or “Effect Icon Window” on page 30.

For the operations on the Icon list, see “Registering an 
Icon in a Category” on page 87.

2 Search block1 ADD button

5 Create New 
button

6 Icon Library

4 Edit button

3 Delete button
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Video Icon Window

The Video Icon window allows you to create or edit a 
Video Icon. To display the window, click [Create New] on 
the Icon Library of the Video tab.

a Icon preview
Thumbnail and name of the created Video Icon is 
displayed.

b Icon property setting block
Specify the following for a Video Icon:

• Icon Name: Input the desired Icon name in up to 8 
alphanumeric characters. 

• Thumbnail: Click [Ref.] to display an image list and 
select the desired image for the thumbnail.

• Class: Select the desired class for a new Icon to narrow 
down the devices to be displayed, since devices are 
classified into classes.

• Device: Select the device according to the class you 
select for a new Icon.

c Camera Control block
When you select an Icon whose class is Camera, specify 
the following:

• Manual/Auto: Specify whether you control the camera 
manually or automatically. When you check [Auto] the 
following Show and Shot boxes become enabled.

• Show: According to the device you select, the 
corresponding Shows are displayed. From among these 
Shows, select the desired Show. 

• Shot: According to the Show you select, the 
corresponding Shots are displayed. From among these 
Shots, select the desired Shot.

• Import: Click to recall the Show/Shot information.

d OK/Cancel/Save/Save as buttons
When you create a new Icon, OK and Cancel buttons are 
displayed. When you edit an existing Icon, Save, Save as, 
and Cancel buttons are displayed.

• OK:  Adds the created Icon to the Icon Library.

• Cancel: Cancels the settings and returns to the Icon 
Manager main window.

• Save: Saves the settings, overwriting the existing Icon.

• Save as: Saves the settings as a new Icon.

For the operations on the Video Icon window, see “Video 
Icons” on page 70.

1 Icon preview 

2 Icon property setting block

4 OK/Cancel/Save/Save as   
      buttons

3 Camera Control block
27Icon Manager Window
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Audio Icon Window

The Audio Icon window allows you to create or edit an 
Audio Icon. To display the window, click [Create New] on 
the Icon Library of the Audio tab.

a Icon preview
Thumbnail and name of the created Audio Icon is 
displayed.

b Icon property setting block
Specify the following for an Audio Icon:

• Icon Name: Input the desired Icon name in up to 8 
alphanumeric characters. 

• Thumbnail: Click [Ref.] to display an image list and 
select the desired image for the thumbnail.

• Class: Select the desired class for a new Icon to narrow 
down the devices to be displayed, since devices are 
classified into classes.

• Device: Select the device according to the class you 
select for a new Icon.

c OK/Cancel/Save/Save as buttons
When you create a new Icon, OK and Cancel buttons are 
displayed. When you edit an existing Icon, Save, Save as, 
and Cancel buttons are displayed.

• OK:  Adds the created Icon to the Icon Library.

• Cancel: Cancels the settings and returns to the Icon 
Manager main window.

• Save: Saves the settings, overwriting the existing Icon.

• Save as: Saves the settings as a new Icon.

For the operations on the Audio Icon window, see “Audio 
Icons” on page 72.

1 Icon preview        

3 OK/Cancel/Save/Save as
      buttons

2 Icon property setting block
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Transition Icon Window

The Transition Icon window allows you to create or edit a 
Transition Icon. To display the window, click [Create 
New] on the Icon Library of the Transition tab.

a Icon preview
Thumbnail and name of the created Transition Icon is 
displayed.

b Icon property setting block
Specify the following for a Transition Icon:

• Icon Name: Input the desired Icon name in up to 8 
alphanumeric characters. 

• Thumbnail: Click [Ref.] to display an image list and 
select the desired image for the thumbnail.

• Class: Select the desired class for a new Icon to narrow 
down the devices to be displayed, since devices are 
classified into classes.

c Detailed setting block
Depending on the Class you select, the necessary settings 
items are enabled. Set the following:

• Pattern No.: Input the desired Pattern number.

• Direction: Select either Normal or Reverse.

• Snapshot No.: Specify the snapshot number.

• Number of DME CH: Select DME channel number the 
Icon is to use.

• Macro: Select Macro No., Macro Transition Rate, and 
Next Transition Delay.

d OK/Cancel/Save/Save as buttons
When you create a new Icon, OK and Cancel buttons are 
displayed. When you edit an existing Icon, Save, Save as, 
and Cancel buttons are displayed.

• OK:  Adds the created Icon to the Icon Library.

• Cancel: Cancels the settings and returns to the Icon 
Manager main window.

• Save: Saves the settings, overwriting the existing Icon.

• Save as: Saves the settings as a new Icon.

For the operations on the Transition Icon window, see 
“Transition Icons” on page 73.

1 Icon  preview

3 Detailed settings block

2 Icon property setting block

4 OK/Cancel/Save/Save as
      buttons
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Effect Icon Window

The Effect Icon window allows you to create or edit an 
Effect Icon. To display the window, click [Create New] on 
the Icon Library of the Effect tab.

a Icon preview
Thumbnail and name of the created Effect Icon is 
displayed.

b Icon property setting block
Specify the following for an Effect Icon:

• Icon Name: Input the desired Icon name in up to 8 
alphanumeric characters. 

• Thumbnail: Click [Ref.] to display an image list and 
select the desired image for the thumbnail.

• Class: Select the desired class for a new Icon to narrow 
down the devices to be displayed, since devices are 
classified into classes.

c Bus Settings block
The buses that can be used for a switcher are displayed. 
Select the bus to be used.

d Snapshot Settings block
Depending on the Class you select, the necessary settings 
items are enabled. Set the following:

• Number of Snapshot Groups: Select how many 
Snapshot Groups should be used (1 to 4).  

• Standby Group#: Select the first snapshot which will 
be recalled when the corresponding cue is on the air. 

• Group Item: Specify the corresponding region and 
register numbers for the snapshot to be recalled by 
pressing the associated buttons on the Shot Box Module. 
A group stands for a combination of snapshots registered 
as a group. 

• Number of DME CH: Select the number of DME 
channels to be used in the Icon.

1 Icon preview

4Snapshot Settings block 

3 Bus Settings 
     block 

2 Icon property 
     setting block

6 OK/Cancel/Save/Save as 
     buttons

5Manual Switching setting 
    block
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e Manual Switching settings block
Setting the manual switching operation while on the air:

• Off: Manual switching becomes disabled.

• On: Manual switching becomes effective. Select the 
buses of which you want to make manual switching. 

f OK/Cancel/Save/Save as buttons
When you create a new Icon, OK and Cancel buttons are 
displayed. When you edit an existing Icon, Save, Save as, 
and Cancel buttons are displayed.

• OK:  Adds the created Icon to the Icon Library.

• Cancel: Cancels the settings and returns to the Icon 
Manager main window.

• Save: Saves the settings, overwriting the existing Icon.

• Save as: Saves the settings as a new Icon.

For the operations on the Effect Icon window, see “Effect 
Icons” on page 76.

Source Window

The Source window allows you to change source settings 
of the bus, create or edit an Effect Icon. To display the 
window, double-click the desired thumbnail in the Bus 
Settings block of the Effect Icon window.

a Not Demand /Demand option buttons
Select whether you set a Video Icon to the bus:  

• Not Demand: Select this option so that you will not be 
prompted to select an image for the Bus in the Cue Edit 
window.

• Demand: Select this option so that you will be 
prompted to select an image for the Bus in the Cue Edit 
window.

b Bus Name
Input the desired bus name in up to 8 alphanumeric 
characters.

c OK/Cancel buttons
Saves or cancels the bus settings:

• OK:  Executes the Bus settings and returns to the Effect 
Icon window.

• Cancel: Cancels the Bus settings and returns to the 
Effect Icon window.

For the operations on the source window, see “Setting in 
the source window” on page 77.

3OK/Cancel buttons

2 Bus  Name1 Not Demand/Demand
      option buttons
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Category Window

The Category window allows you to create a new category 
to accommodate icons. To display the window, click 
[Create New] or [Edit] on the Category List of the Icon 
Manager window.

a Category property setting block
Specify the following for an Icon:
• Category Name: Input the category name in up to 25 

alphanumeric characters.

• Category Type: Select the desired type according to 
the Icons that you want to save in the category.

b Delete button
Click to delete the Icon selected in the Icon Library.

c Icon preview
Thumbnail and name of the Icon selected from the Icon 
Library are displayed.

d Icon Library
According to the selected category type, registered Icons 
are displayed. 

e OK/Cancel buttons
When you create or edit a category, click the OK or Cancel 
button.

• OK:  Adds the category to the end of the Category List 
in creating a new category, or executes the settings in 
editing a category. Then returns to the Icon Manager 
main window.

• Cancel: Cancels the operation and returns to the Icon 
Manager main window.

For the operations on the  Category window, see “Setting 
Categories” on page 82.

1 Category property setting 
     block

4Icon Library 

5OK/Cancel buttons

2 Delete button 

3 Icon preview 
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ELC Plug-in Window

The ELC Plug-in application is designed so ELC operators 
can drag a cue from the Quick Cue and paste it into an 
NRCS rundown as an ELC object, so that an ELC playlist 
is created easily. The application is also used to create and 
edit a cue. 

The ELC Plug-in window is displayed as part of the NRCS 
client window. The ELC Plug-in application is composed 
of the following two modules: 
• Quick Cue 
• Cue Edit

When using iNEWS
To display the ELC Plug-in application, first start the 
iNEWS client workspace, and select [Menu] > [Plug-in] > 
[ELC Plug-in]. 

For the operations on the ELC Plug-in window, see 
“Preparing Cues (ELC Plug-in)” on page 91, “Creating a 
Playlist for iNEWS (ELC Plug-in/Playlist Viewer)” on 
page 119, and “Editing an ELC Production Cue added to 
an iNEWS rundown” on page 126.

1 iNEWS menu bar and toolbar
The menu bar and toolbar provide iNEWS menus and tool 
buttons.  For details, see the user’s guide of the iNEWS.

2 iNEWS queue panel
The panel displays the rundown selected in the directory 
panel, where the stories are listed in the order they are to 
rundown.

2 iNEWS 
queue 
panel

4 iNEWS 
story text 
panel

1 iNEWS menu 
bar and 
toolbar

1 Plug-in 
windows tabs

2 Version 
button

3 Quick Cue 
or Cue Edit 
tab

3 iNEWS 
story form 
panel

5 iNEWS 
instruction 
panel1, 2, 3, 4, 5 :Parts of iNEWS client window

1, 2, 3 :Parts of  ELC Plug-in window 
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3 iNEWS story form panel
The panel shows the information about the iNEWS story, 
which contains fields for data that typically appear in the 
rundown: the playout server channel, VID-ID setting, the 
story title, the length of the story, and the status of the 
story. 
To display the status of the playout server in the ELC 
playlist, it is required to fill in the VID-ID and CH 
columns.

4 iNEWS story text panel
The panel displays the text or script of the selected story in 
the Queue panel. You can  drag and drop a cue from the 
Quick Cue window to add a new production cue.

5 iNEWS instruction panel
The panel displays the production cue of the selected 
iNEWS story.

1 Plug-in windows tabs
Click the Quick Cue or the Cue Edit tab to display relevant 
tab.

2 Version button
Click the icon to show the version number of the ELC 
Plug-in application.

3 Quick Cue or Cue Edit tab
The window displays either the Quick Cue or the Cue Edit 
tab.

When using ENPS
To display the ELC Plug-in application, first start the 
ENPS client workspace, and click the rover (green dot) of 
the Media Control icon on the bottom bar of the window, 
and select [ELC Plug-in] from the displayed menu. 

For the operations on the ELC Plug-in window, see 
“Preparing Cues (ELC Plug-in)” on page 91, “Creating a 
Playlist for ENPS (ELC Plug-in/Playlist Viewer)” on page 
130, and “Editing an ELC Item added to an ENPS 
rundown” on page 134.

4 ENPS 
editing 
window 
(script)

1 ENPS 
list 
window

1 Plug-in 
windows 
tabs

2 Version 
button

3 Quick Cue 
or Cue Edit 
tab

3 ENPS 
folders, 
search 
window, and 
icons bar

1, 2, 3, 4 :Parts of ENPS client window

1, 2, 3 :Parts of ELC Plug-in window

2 ENPS 
rundown 
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1 ENPS list window
The list window displays the folder list, from which you 
can select and open a rundown.

2 ENPS rundown
The window displays the rundown selected and opened 
from the ENPS list window, where the stories are listed in 
the order they are to rundown.

3 ENPS folders, search window, and icons bar
The bar contains folders, a search window, and the icons 
including My ENPS, Printer, and Media Control from 
which you can launch the ELC Plug-in application. 

4 ENPS editing window (script)
The window displays the script of the item selected on the 
rundown. You can  drag and drop a cue from the Quick 
Cue window to add a new item. 

1 Plug-in windows tabs
Click the Quick Cue or the Cue Edit tab to display relevant 
tab.

2 Version button
Click the icon to show the version number of the ELC 
Plug-in application.

3 Quick Cue or Cue Edit tab
The window displays either the Quick Cue or the Cue Edit 
tab.

Quick Cue Tab

The Quick Cue tab is used to set a production cue/an item 
to the NRCS client window. 

For the operations on the Quick Cue tab, see “Creating a 
Cue” on page 93 and “Editing a Cue Registered in Quick 
Cue” on page 103.

a Cue folder list
The folders containing cues are listed. Click the desired 
cue folder so that the cues in it are displayed in the cue list.

b Cue list
Thumbnails of the cues contained in the cue folder selected 
in the cue folder list are displayed.

2 Cue list1 Cue folder 
list
35ELC Plug-in Window
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Cue Edit Tab

The Cue Edit tab is used to edit a cue created in the Quick 
Cue tab.

For the operations on the  Cue Edit tab, see “Managing 
Cues” on page 93, “To set a new production cue after 

checking the content of a cue” on page 122 (for iNEWS), 
and “To set a new item after checking the content of a cue” 
on page 133 (for ENPS).

a List of the settings to be changed
The panel lists the settings you can change for the item 
currently selected on the Current Cue panel.

b Current cue
Displays the settings of the cue currently selected or being 
edited. The content differs depending on the cue settings.
For details on cues, see “1 Cue” on  page 38. 

The window does not show the playout server and camera 
status.

c Detailed settings
The panel displays the detailed settings of the items 
selected in the list of the settings to be changed.

d Icon/File list
The list displays thumbnails of the Icons contained in the 
selected category in the Category list.

e Category list
The list displays the categories created in the Icon 
Manager application.

f Save/Save as buttons 
When you edit an existing cue by right-clicking it and 
selecting Edit menu, the following buttons are displayed.

• Save: Saves the setting, overwriting the existing one.

• Save as: Saves the settings as a new cue by opening a 
dialog box to name the cue.  

g Registration icon
When you double-click an existing cue in the Quick Cue 
window, the registration icon is displayed. This icon is 
used to register the cue loaded in the current cue onto the 
NRCS rundown.

h Apply button (ENPS only) 
This button appears depending on the contents of the 
editions. It is used when double-clicking and editing an 
Item pasted on the ENPS editing window (script).

1 iNEWS buttons
The buttons appear depending on the contents of editions. 
The buttons are used when double-clicking and editing a 
Production cue pasted on the iNEWS story panel:

• OK:  Reflects the changes in settings and the ELC Plug-
in window is closed.

• Apply: Reflects the changes in settings.

• Cancel: Cancels the settings and the ELC Plug-in 
window is closed.

1 List of the 
settings to 
be changed

3 Detailed 
settings

5Category list

4Icon /File list

1 iNEWS buttons (OK/Cancel/Apply)

2Current cue

7 Registration icon

6 Save/Save 
as buttons

8 Apply button (ENPS only)

1 to 8 :Parts of ELC Plug-in window
1 :Parts of iNEWS client window

Note
ELC Plug-in Window
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OA Playlist and Playlist Viewer Windows

The OA Playlist window is designed for ELC operators  to 
play out the playlist created in ELC Plug-in application.  
The Playlist Viewer window is designed to check the 
playlist. The two windows look the same, except for the 
menu bar items. Differences in functions will be explained 
in the explanations in this section. 
To start the OA Playlist application or Playlist Viewer 
application, double-click the relevant icon on the desktop. 

For the operations on the OA Playlist and Playlist Viewer 
windows, see the following:

• For iNEWS: See “Creating a Playlist” on page 121, 
“Displaying a Playlist in the Playlist Viewer 
Application” on page 128, and “On-Air Operations” on 
page 138.

• For ENPS: See “Creating a Playlist” on page 132, 
“Displaying a Playlist in the Playlist Viewer 
Application” on page 136, and “On-Air Operations” on 
page 138.

a Playlist name
The playlist name (up to 25 alphanumeric characters) 
provided by the NRCS client software is displayed, which 
is the same as the queue name of the NRCS rundown.

b Menu bar
The bar provides the menus for using the OA Playlist and 
Playlist Viewer:
• File menu: 

Open: Opens a playlist on the OA Playlist or Playlist 
Viewer window.
Close: Closes the playlist on the OA Playlist or Playlist 

Viewer window
Exit: Exits the OA Playlist or Playlist Viewer window.

• Playlist menu (OA Playlist window only):
Start: Starts the on-air operation.
End: Ends the on-air operation.

• Help menu:
Version: Displays the version number.
Help: Displays this User’s Guide.

c ELC playlist
The stories are listed in the order that they are played out.

1Playlist name

8Current
     button

7 ELC 
story

1 Cue

2Menu bar

3ELC playlist

4Page/Slug 

5Error mark

6Error monitor
37OA Playlist and Playlist Viewer Windows
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d Page/Slug
Displays the page and slug, set by the NRCS, of the story 
to which an ELC production cue/item is registered. 

e Error mark
The error mark appears when the corresponding cue 
has a problem or problems. Without lessening or solving 
the problem(s), it will be difficult to execute the cue. 
The error details are displayed in the error monitor area. 

f Error monitor
Displays the error details of a cue beside which an error 
mark is displayed: 

The selected cue is displayed with a blue selection frame. 
To display all the errors one by one, click  or . To 
select a cue directly, click the desired cue on the playlist.
If the subject cue of the error monitor is not displayed on 
the playlist, double-click on the error monitor, and the 
playlist will be scrolled to show the subject cue.

g ELC Story
An ELC Story definition differs between iNEWS and 
ENPS:
• In iNEWS: A group of cues of the same NRCS Page 

number is defined as an ELC story.
• In ENPS: A group of cues of the same NRCS Slug is 

defined as an ELC story.

h Current button
While scrolling a playlist manually, press this button to 
enter into the auto scrolling mode and to display the cue 
being on the air on the second line from the top 
immediately.  

1 Cue
A unit to be on the air with a TAKE operation.
The content differs depending on the cue settings. The 
following is an example:

a Transition Icon
The thumbnail of the Transition Icon is displayed.

b Video Icon
The thumbnail of the Video Icon is displayed:
• When an Effect Icon is set: The Effect Icon 

thumbnail is displayed.
• When no Effect Icon is set: The thumbnail of Video 

Icon set to A Bus is displayed.

c Keys
Displays thumbnails and names of Video Icons assigned to 
keys 1 to 4. When the playout server is set, the name of the 
system icon automatically set is displayed before the 
channels are set. After the channel is set, the name of the 
icon the user specifies for each channel is displayed.

d Playout server status
The status of multiple channels of the playout server is 
obtained from the NRCS and displayed*:

Page number Error message

Error number (A number between 2000 to 2999 is 
displayed.)

1Transition Icon

6Audio3Keys2Video Icon

4Playout server status

5Camera status

7OA Cue

8 NEXT Cue
OA Playlist and Playlist Viewer Windows
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* Only two channels with the highest and the second 
highest priorities, which correspond to the first and the 
second channels listed from the top of the list of the 
settings to be changed, are displayed.

e Camera status
The status of robotic cameras 1 to 8 is displayed*:

* Only two devices with the highest and the second highest 
priorities, which correspond to the first and the second 
devices listed from the top of the list of the settings to be 
changed, are displayed.

f Audio
The panel displays the settings of audio fader numbers 1 to 
8: names of the Audio Icons, level, Fade In/Out settings. 
When the playout server is set, the name of the system icon 
automatically set is displayed before the channels are set. 
After the channel is set, the name of the icon the user 
specifies for each channel is displayed.

g OA Cue
The cue being on the air is displayed in green. In the auto 
scroll mode, it is always placed on the second line from the 
top. 

h NEXT Cue
The cue to be on the air next is displayed in yellow. When 
the next cue is not ready, it flashes in yellow. Then it lights 
in yellow when it is ready.
 

Status Icon Description

No 
Response

The playout server does not 
respond.  

Not Filed No files are saved in the playout 
server. 

Filed
OA

NEXT

Other

Files to be used are saved. 

Cued
OA

NEXT

Other

Files are cued up (stand-by).

Play Files are being played.

Channel number

Status

Device number

Status

Status Icon Description

No 
Response

The camera does not respond.  

Not Ready Although the camera responds, no 
shot is recalled. 

Ready
OA

NEXT

Other

The camera is on standby. If there is 
a shot, shot is recalled. 

Manual
OA

NEXT

Other

The status of a manually-set camera  
is always displayed.
39OA Playlist and Playlist Viewer Windows



Preparations
The section explains preparations and setup that technical directors 
or a system integrator should do before making news programs: 
making the initial setup with the Initial Setup application, creating 
Icons with the Icon Manager, and making cues in the ELC Plug-in 
application.  If necessary, ELC operators can refer to and change 
required settings.
Chapter 6 explains required preparations that directors should do 
when they use advanced functions of the software: switching 
multiple snapshots and videos manually.

Chapter 3   Making the Initial Setup ............................................. 41

Chapter 4   Preparing Icons (Icon Manager) ............................... 65

Chapter 5   Preparing Cues (ELC Plug-in)................................... 91

Chapter 6  Preparing for Advanced Manual Operations .......... 108
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3Making the Initial Setup
Overview

Before starting routine operations of the ELC-MVS01 software, when a new 
news program is planned, or when there is a change on a device in the studio, a 
technical director can set up the following items of the system using the Initial 
Setup application:

• Video Switcher Settings (see page 44)
It allows you to associate each video input signal of the video switcher with a 
Video Icon registered in the ELC-MVS01 software.
It also specifies transition rate options for the Transition Icons.

• Audio Mixer Settings (see page 47)
It allows you to associate each audio input signal of the audio mixer with an 
Audio Icon registered in the ELC-MVS01 software or a back fader of the 
audio fader panel.
It also specifies audio level options and fade-in/fade-out time options.

• Shot Box Module Assign (see page 54)
It allows you to assign the functions to be used for manual on-air operations 
to the buttons on the shot box module.

• DDR(VDCP) File List Creation (see page 59)
It allows you to select the video files used in the news programs from all the 
files stored on the DDR(VDCP), so that they will be listed upon creating cues 
and easily added to a playlist.

• Audio Server File List Creation (see page 62)
It allows you to select the audio files used in the news programs from all the 
files stored on audio server, so that they will be listed upon creating cues and 
easily added to a playlist.
41Overview
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Starting the Initial Setup Application

1 Double-click the InitSetup icon (Initial Setup) on the Windows desktop.
Or, double-click the InitSetup.exe file in the “Sony\ELC\InitialSetup” 
folder on the drive where the ELC-MVS01 software is installed.

The Initial Setup application starts and the Initial Setup Main Menu is 
displayed.

2 Select a sub menu on the Initial Setup Main Menu, depending on the desired 
setup items.

The window corresponding to the selected sub menu is displayed.

Example: Video Switcher Settings window
Starting the Initial Setup Application
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Only one Initial Setup application can be operated in a system at a time. If the 
Initial Setup application is already operating on the same computer, or on a 
different computer in the system, you cannot start the application.

Exiting the Initial Setup Application

1 Select [File] > [Exit] from the menu bar of the Initial Setup Main Menu.

The Initial Setup application is closed.

Note
43Starting the Initial Setup Application
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Making the Video Switcher Settings

The Video Switcher Settings window is used to associate each video input 
signal of the video switcher with a Video Icon used in the ELC-MVS01 
software.
The Icon Manager application is used to associate each video device with a 
Video Icon. The Video Switcher Settings window of the Initial Setup 
application is used to register associations between the video devices and the 
video input signals, which correspond to V/K pair numbers, of the video 
switcher.

For details on the Icon Manager, see “Creating Icons” on page 69.

The Video Switcher Settings window also enables you to specify the transition 
rate options to be used when editing cues.

Associating the V/K Pair Numbers with Video Icons

1 On the Initial Setup Main Menu, click the Video Switcher Settings sub 
menu.

The Video Switcher Settings window is displayed.

The Initial Setup application enables you to import and view the source 
names for the V/K pair numbers specified on the video switcher, so that you 
can check the device you want to associate with a certain V/K pair number.

For details, see “To import source names from the video switcher” on page 
45.

Note

Import button
Making the Video Switcher Settings
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2 Narrow down the device list, if necessary, by selecting the desired class 
using the Class drop-down list box. 

You can select from the following options.

3 Select the device to be associated with the selected V/K pair number, using 
the Device drop-down list box.

Now the V/K pair number and the Video Icon that represents the selected 
device are associated.

4 Repeat steps 2 and 3 for all the V/K pair numbers to be used in the system.

5 Click [Save] to save the modified settings.

To import source names from the video switcher
Click [Import] in the Video Switcher Settings window.
A warning message is displayed.
Click [OK] to import the source names from the video switcher.
The names are displayed in the Source Name column.

Class Descriptions

All All devices will be displayed in the Device List drop-
down list box.

Camera Select this option to specify a camera Icon.

CG/Still Store Select this option to specify a CG or Still Store Icon. 
Tip
The CG/Still Store is a server having a playlist 
function. The CG/Still Store controller type with a 
playlist function and a storage type can be a different 
device.The ELC-MVS01 does not control the CG/Still 
Store and does not perform file operations. With the 
tally off signal from the switcher, next piece of 
material on the playlist will be loaded for standby.

DDR(VDCP) Select this option to specify a DDR(VDCP) Icon.
Tip
A disk recorder without a playlist function is 
supported. It handles frequently-used daily materials. 
You can specify files from the ELC-MVS01.

DDR(SonyVTR) Select this option to specify a DDR(SonyVTR) Icon. 
Use this option for a digital disk recorder that can be 
controlled by the Sony VTR protocol.

Ext/Others Select this option to specify, a Color Background, or 
Re-Entry Icon within the switcher. 

Frame Memory Select this option to specify a Frame Memory Icon 
within the switcher.

PO Server Select this option to specify a playout server Icon. 
Tip
A playout server is a server having a playlist function. 
It handles daily-changing materials. The playout 
server controller type with a playlist function and a 
storage type can be a different device. The ELC-
MVS01 controls the playback function only and does 
not select files. When a file is played to the end, the 
next piece of material on the playlist will be loaded 
automatically for standby. 

Remote Select this option to specify a remote Icon.
45Making the Video Switcher Settings
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Specifying the Transition Rate Options

The following procedure specifies the two sets of transition rate options: video 
transition rate options and key transition rate options. They will appear in the 
Cue Edit window of the ELC Plug-in application as the options for switching 
two cues and for a key event, respectively.

1 In the Video Switcher Settings window, specify the number of frames for 
each of the four transition rate options using the spin boxes in the Video 
Transition Rate section.

You can enter the desired number of frames (0 to 999) into each spin box, 
or increase/decrease the setting by clicking the spin buttons.

The transition rate for an option will be displayed in the “SS:FF” format in 
the Cue Edit window of the ELC plug-in application.

In the same way, specify the number of frames for each of the four transition 
rate options that are used for a key event, using the spin boxes in the Key 
Transition Rate section.

2 Click [Save] to save the modified settings.

Note
Making the Video Switcher Settings
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Making the Audio Mixer Settings

The Initial Setup application shows the Audio Mixer Settings window, in which 
a technical director makes the following settings related to the audio mixer.

• Associating a fader number of the audio mixer with an Audio icon
This makes the fader of the audio mixer accept automatic control from the 
ELC-MVS01 system. An Audio Icon registered in the system is associated 
with a fader number of the audio mixer.

• Associating a fader number of the audio mixer with a back fader of the 
audio fader panel for manual operation
This makes the fader of the audio mixer accept manual control from the ELC-
MVS01 system. One of the eight back faders of the audio fader panel is 
associated with a fader number of the audio mixer.

• Disabling control of a fader of the audio mixer from the ELC-MVS01 
system
This disables control of a fader of the audio mixer from the ELC-MVS01 
system.

The Audio Mixer Settings window is also used to specify the audio level 
options, and fade in/out time options for the fader numbers that accept automatic 
control from the ELC-MVS01 system.

Audio Fader Panel
47Making the Audio Mixer Settings
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Associating Fader Numbers with Audio Icons

1 On the Initial Setup Main Menu, click the Audio Mixer Settings sub menu.

The Audio Mixer Settings window is displayed.

For details, see “Audio Mixer Settings Window” on page 20.

The Initial Setup application enables you to import and view the source 
names for the fader numbers specified on the audio mixer, so that you can 
check the device you want to associate with a certain fader number.

For details, see “To import source names from the audio mixer” on page 
50.

2 Select [Enable] in the Control drop-down list box for a fader number.

3 Associate the desired Audio Icon with the fader number.
Narrow down the device list, by selecting the desired class using the Class 
drop-down list box. 

You can select from the following options.

Note

Import button
Making the Audio Mixer Settings
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4 Select the device to be associated with the selected fader number, using the 
Device drop-down list box.

The fader on the audio mixer and the Audio Icon that represents the selected 
device are now associated.
While a cue with the associated Audio Icon is on the air, the audio level will 
be adjusted to the level specified in the cue automatically. You can also use 
the corresponding fader on the audio fader panel.

For details on on-air operations, see “Starting/Ending On-Air Operation” 
on page 140, and “Controlling the Audio Level Manually” on page 148.

5 Repeat steps 2 to 4 to associate another fader number with an Audio Icon.

6 Click [Save] to save the modified settings.

Class Descriptions

All All devices will be displayed in the Device List drop-
down list box.

Audio Server Select this option to specify an audio server Icon. 

CG/Still Store Select this option to specify a CG or Still Store Icon. 
Tip
The CG/Still Store is a server having a playlist 
function. The CG/Still Store controller type with a 
playlist function and a storage type can be a different 
device. The ELC-MVS01 does not control the CG/Still 
Store and does not perform file operations. With the 
tally off signal from the switcher, next piece of 
material on the playlist will be loaded for standby.

DDR(VDCP) Select this option to specify a DDR(VDCP) Icon.
Tip
A disk recorder without a playlist function is 
supported. It handles frequently-used daily materials. 
You can specify files from the ELC-MVS01.

DDR(SonyVTR) Select this option to specify a DDR(SonyVTR) Icon. 
Use this option for a digital disk recorder that can be 
controlled by the Sony VTR protocol.

Ext/Others Select this option to specify an Audio Icon for which 
the device control is not required. 

PO Server Select this option to specify a playout server Icon. 
Tip
A playout server is a server having a playlist function. 
It handles daily-changing materials. The playout 
server controller type with a playlist function and a 
storage type can be a different device. The ELC-
MVS01 controls the playback function only and does 
not select files. When a file is played to the end, the 
next piece of material on the playlist will be loaded 
automatically for standby.

Remote Select this option to specify a remote Icon.
49Making the Audio Mixer Settings
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To import source names from the audio mixer
Click [Import] in the Audio Mixer Settings window.
A warning message is displayed.
Click [OK] to import the source names from the audio mixer.
The names are displayed in the Source Name column.

Note on importing source names
To import the source names, the source name information must be exported as 
a csv file described below in advance. This advanced procedure is required only 
when you are using a stereo fader mixer. 

• File name: ExportSignals.csv
• Location: “Sony\ELC\DeviceCtrl” folder on the drive where the ELC-

MVS01 software is installed.

Use the Xpoint software that is included in the audio mixer to export the 
information. 
Ask your system administrator for details.

Associating Fader Numbers with Back Faders of the Audio Fader Panel for 
Manual Operation

The Initial Setup application enables you to import and view the source names 
for the fader numbers specified on the audio mixer, so that you can check the 
device you want to associate with a certain fader number. The imported source 
names are also displayed on the source buttons on the audio fader panel for the 
back faders for manual fader control (channels B1 to B8).

For details, see “To import source names from the audio mixer” on page 50.

Note
Making the Audio Mixer Settings
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1 In the Audio Mixer Settings window, select one of the [Manual Fader B1] 
to [Manual Fader B8] options in the Control drop-down list box on the line 
for a fader number of the audio mixer.

The fader on the audio mixer now accepts manual fader control from the 
ELC-MVS01 system.
During on-air operation, the specified back fader (B1 - B8) of the audio 
fader panel can be used for manual control.

2 Repeat step 1 to associate another fader number of the audio mixer with a 
back fader of the audio fader panel.

3 Click [Save] to save the modified settings.

Disabling Control of Faders of the Audio Mixer from the ELC-MVS01 System

1 In the Audio Mixer Settings window, select [Disable] in the Control drop-
down list box for a fader number.

The fader on the audio mixer can no longer be controlled from the ELC-
MVS01 system. 

2 Repeat step 1 to disable control of other faders from the system.

3 Click [Save] to save the modified settings.
51Making the Audio Mixer Settings
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Specifying the Audio Level Options

The following procedure specifies the audio level options for automatic fader 
control from the ELC-MVS01 system. The audio level options will be used in 
the Cue Edit window of the ELC plug-in application when editing cues.
When a cue is taken during on-air operation, the audio level will automatically 
be adjusted to the one specified for the cue.

For details on editing cues, see“Setting Audio” on page 99.

1 In the Audio Mixer Settings window, specify the audio level for each of the 
three audio level options using the spin boxes in the Level section.

You can enter the desired number (-99 to 0) into each spin box, or increase/
decrease the setting by clicking the spin buttons.

When editing cues, there is one more audio level option “0” that is set at 
–∞ dB, besides these three options and it cannot be modified.

2 Click [Save] to save the modified settings.
Making the Audio Mixer Settings
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Specifying the Fade In/Out Time Options

The following procedure specifies the audio fade in/out time options for 
automatic fader control from the ELC-MVS01 system. The fade in/out time 
options will be used in the Cue Edit window of the ELC plug-in application 
when editing cues.
When a cue is taken during on-air operation, the fade in/out time specified for 
the cue is used for playout automatically.

1 In the Audio Mixer Settings window, specify the number of frames for each 
of the four fade in/out time options, using the spin boxes in the Fade In/Out 
Time section.

You can enter the desired number of frames (0 to 60) into each spin box, or 
increase/decrease the setting by clicking the spin buttons.

The fade in/out time for an option will be displayed in the “SS:FF” format 
in the Cue Edit window of the ELC plug-in application.

2 Click [Save] to save the modified settings.

Note
53Making the Audio Mixer Settings
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Assigning Functions to the Shot Box Module Buttons

The Shot Box Module Assign window is used to assign manual on-air functions 
to the buttons on the ELC-MVS01 shot box module. This setup enables an ELC 
operator to use the assigned manual function easily during on-air operation, by 
selecting the corresponding button.

• When there are two shot box modules used in the system, this setup makes the 
identical assignment to both shot box modules.

• During on-air operation, a change in setting will not be reflected immediately. 
The next time you open a playlist with the OA Playlist application, the 
windows will reflect the changes.  

Assigning a Function to a Button

1 On the Initial Setup Main Menu, click the Shot Box Module Assign sub 
menu.

The Shot Box Module Assign window is displayed.

2 Select the tab corresponding to the bank to which you want to assign the 
functions.

The functions that have already been assigned to the buttons of the selected 
bank are displayed in the Assign List.

Notes

Button layout
Assigning Functions to the Shot Box Module Buttons
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3 Select the function(s) to be assigned on the Function List.
To select more than one function, hold down the Ctrl key, and click the 
desired functions.
To select all functions in a range, hold down the Shift key, and click the first 
and last functions in the range.

There are the following functions on the Function List.

4 Select the number corresponding to the button to be assigned with the 
function on the Assign List.
Or, if you select more than one function in step 3, select the lowest number 
of the buttons to which you want to assign the functions. In this case, the 
functions will be assigned to the buttons of the selected and the subsequent 
numbers.

5 Click [CADD].

The selected function(s) are assigned to the button(s), and displayed on the 
Assign List.

6 Repeat steps 2 to 5 if you want to assign another function to a shot box 
module button.

7 Click [Save] to save the modified settings.

Function Description

TAKE Takes the next cue on the playlist while on the air.

DSK1 - 4 ON/OFF Cuts DSK 1 to 4 in or out alternately.

DSK1 - 4 AUTO Inserts or deletes DSK 1 to 4 alternately using the 
transition type and rate specified on the switcher. 

DSK1 - 4 Link Takes the next cue on the playlist, and 
simultaneously inserts or deletes DSK 1 to 4 using 
the transition type and rate specified on the 
switcher.

Snapshot Group 1 - 4 Recalls the snapshot specified as the Snapshot 
Group 1 to 4 Effect Icon.
For details, see “Effect Icons” on page 76.

Manual Switching 1 - 6 Switches to the video signal of the first to sixth 
Video Icon listed for manual switching.
For details, see “Required Settings in the ELC Plug-
in Application” on page 116.

Side Flag for A Bus Turns Side Flag on and off for the A bus of the Next 
Cue.

Side Flag for B Bus Turns Side Flag on and off for the B bus of the Next 
Cue.
55Assigning Functions to the Shot Box Module Buttons
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Specifying the Name of a Button

The following procedure specifies/edits the name for a button on the shot box 
module.

When one of the Snapshot Group 1 to 4 functions is assigned to a button, the 
name of the corresponding Snapshot Group will appear on the button. In this 
case, the Initial Setup application does not allow you to edit the name of the 
button. Use the Icon Manager to edit the name of a Snapshot Group.

For details on editing the name of a Snapshot Group, see “Required Settings in 
the Icon Manager Application” on page 109.

When one of the Manual Switching 1 to 6 functions is assigned to a button, the 
name of the corresponding Video Icon will appear on the button. In this case as 
well, the Initial Setup application does not allow you to edit the name of the 
button. 

For details on the Video Icons used for manual switching, see “Required 
Settings in the ELC Plug-in Application” on page 116.

1 In the Shot Box Module Assign window, select the tab corresponding to the 
desired bank.

The functions assigned to the buttons of the selected bank are displayed in 
the Assign List.

Note
Assigning Functions to the Shot Box Module Buttons
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2 Double-click the Name column on the line for the desired button, and enter 
the name for the button.

• You can enter up to eight alphanumeric characters and symbols. Use the 
symbol “ | ” to insert a line break, which appears only on the shot box 
module.

• Although you can enter both capital and lower case letters here, the names 
will be shown in capital letters on the shot box module.

3 Repeat steps 1 and 2 if you want to specify the name for another button.

4 Click [Save] to save the modified settings.

Removing the Assigned Function

The following procedure removes the function assigned to a button on the shot 
box module.

1 In the Shot Box Module Assign window, select the tab corresponding to the 
desired bank.

The functions assigned to the buttons of the selected bank are displayed in 
the Assign List.

2 Select the line of the button from which you want to remove the assigned 
function on the Assign List.

Notes
57Assigning Functions to the Shot Box Module Buttons
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3 Click [Delete].

A confirmation message is displayed.

4 Click [OK] to remove the function.

The selected function disappear from the list.

5 Repeat steps 1 to 4 if you want to remove the function from another button.

6 Click [Save] to save the modified settings.
Assigning Functions to the Shot Box Module Buttons
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Managing Video Material
- Creating the DDR(VDCP) File List

The Initial Setup application shows the DDR(VDCP) File List Creation 
window, in which a technical director can select the video files to be used in the 
news programs from all the files stored on the DDR(VDCP). The selected files 
will be shown on a list when the DDR(VDCP) is selected during creating or 
editing cues, so that the desired video files can be added to a playlist easily.

All the video files to be used in the ELC-MVS01 system must be listed in 
advance using this DDR(VDCP) File List Creation setup tool.

Creating the File List

1 On the Initial Setup Main Menu, click the DDR(VDCP) File List Creation 
sub menu.

The DDR(VDCP) File List Creation window is displayed. If the file list has 
already been created, it is displayed on the File List in the window.

When the Source Library list, which shows the video files stored on the 
DDR(VDCP), is blank, or when you want to update the list, proceed to step 
2. When it does not need to be updated, proceed to step 4.

2 Select the device in the Device drop-down list box, then click [Import].

Note
59Managing Video Material - Creating the DDR(VDCP) File List



60

  C
hapter 3  M

aking the Initial S
etup
By selecting the device, the port of the DDR(VDCP) to be used to import 
the file information is selected.

A warning message appears.

3 Click [OK] to import the file information.

Importing of the file information starts.
When importing is completed, information on the video files obtained from 
the DDR(VDCP) appears on the Source Library list.

4 Select the desired file(s) on the Source Library list.
To select more than one file, hold down the Ctrl key, and click the desired 
files.
To select all files in a range, hold down the Shift key, and click the first and 
last files in the range.

The File List holds up to 100 files. 

5 Click [C ADD].

The selected file(s) are added at the bottom of the File List.

6 Repeat steps 4 and 5 if you want to add more files to the File List.

7 Click [Save] to save the modified settings.

Changing the Order of the Files

The following procedure changes the order of the files on the File List. You can 
arrange the list, so that files can easily be found when creating/editing cues. 

1 On the File List, select the file, then move it to the desired position on the 
list using a drag and drop operation.

The moved file is inserted at the position where it was dropped.

2 Repeat step 1 if you want to move another file on the list.

3 Click [Save] to save the modified settings.

Note
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Deleting Files from the List

The following procedure deletes the selected files from the File List.

1 On the File List, select the file(s) to be deleted.
To select more than one file, hold down the Ctrl key, and click the desired 
files.
To select all files in a range, hold down the Shift key, and click the first and 
last files in the range.

2 Click [Delete].

A confirmation message is displayed.

3 Click [OK] to delete the file(s).

The selected file(s) disappear from the File List. The remaining files are 
rearranged on the list without any space between them.

4 Click [Save] to save the modified settings.
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Managing Audio Material
- Creating the Audio Server File List

The Initial Setup application shows the Audio Server File List Creation window, 
in which a technical director can select the audio files to be used in the news 
programs from all the files stored on the audio server. The selected files will be 
shown on a list when the audio server is selected while creating or editing cues, 
so that the desired audio files can be added to a playlist easily.

All the audio files to be used in the ELC-MVS01 system must be listed in 
advance using this Audio Server File List Creation setup tool.

Creating the File List

1 On the Initial Setup Main Menu, click the Audio Server File List Creation 
sub menu.

The Audio Server File List Creation window is displayed.

2 Select the desired device for which you would like to create a file list in the 
Device drop-down list box.

If the information on the audio files of the selected device has already been 
imported, the files are displayed on the File List and the Source Library.

Note
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When the Source Library list, which shows the audio files stored on the 
selected audio server, is blank, or when you want to update the list, proceed 
to step 3. When it does not need to be updated, proceed to step 5.

3 Click [Import].

A warning message appears.

4 Click [OK] to import the file information.

Importing of the file information starts.
When importing is completed, information on the audio files obtained from 
the audio server appears on the Source Library list.

5 Select the desired file(s) on the Source Library list.
To select more than one file, hold down the Ctrl key, and click the desired 
files.
To select all files in a range, hold down the Shift key, and click the first and 
last files in the range.

The File List holds up to 100 files. 

6 Click [CADD].

The selected file(s) are added at the bottom of the File List.

7 Repeat steps 5 and 6 if you want to add more files to the File List.

8 Click [Save] to save the modified settings.

Changing the Order of the Files

The following procedure changes the order of the files on the File List. You can 
arrange the list so that files can easily be found when creating/editing cues. 

1 Select the desired audio server in the Device drop-down list box.

The file information created for the audio server is displayed on the File 
List.

2 On the File List, select the file, then move it to the desired position on the 
list using a drag and drop operation.

The moved file is inserted at the position where it was dropped.

3 Repeat step 2 if you want to move another file on the list.

4 Click [Save] to save the modified settings.

Note
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Deleting Files from the List

The following procedure deletes the selected files from the File List.

1 Select the desired audio server in the Device drop-down list box.

The file information created for the audio server is displayed on the File 
List.

2 On the File List, select the file(s) to be deleted.
To select more than one file, hold down the Ctrl key, and click the desired 
files.
To select all files in a range, hold down the Shift key, and click the first and 
last files in the range.

3 Click [Delete].

A confirmation message is displayed.

4 Click [OK] to delete the file(s).

The selected file(s) disappear from the File List. The remaining files are 
rearranged on the list without any space between them.

5 Click [Save] to save the modified settings.
Managing Audio Material - Creating the Audio Server File List
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4Preparing Icons
(Icon Manager)
Overview of Icons 

The Icon Manager application allows you to create Video, Audio, Transition, 
and Effect Icons, which are elements to make a cue. The software also provides 
categories to classify Icons. This section provides an overview of Icons and 
categories you can create with the Icon Manager application.

Icons
An Icon symbolizes frequently-used settings of a video switcher, audio mixer, 
or devices for materials such as a camera, server, or CG. The following four 
types of Icons are available:

• Video Icon 
A Video Icon represents video materials of cameras, video servers, CG, and 
DDR. It is used to change video materials.

• Audio Icon
An Audio Icon represents audio materials of an audio server, or video server. 
It is used to change audio materials.

• Transition Icon
A Transition Icon represents a video transition setting. Various video 
transition settings are registered as a “snapshot” in the switcher, and the 
Transition Icon represents the snapshot.  It is used to make the transition from 
one cue to the next one.

• Effect Icon
An Effect Icon represents a setting of compound video effects. A frequently-
used effect is registered as a “snapshot” in the switcher, and the Effect Icon 
represents the snapshot. It is used to set a video effect.

 

An Effect Icon contains a Video Icon as an element.  Create an Effect Icon after 
the Video Icon is created.

In addition, the following icon is supplied by the system:

System Icons
The following System Icons are prepared by the ELC-MVS01 software and the 
users are thus not required to prepare them:

Note
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• Continuous
Audio and Video Icons for which class is designated as Continuous are used  
when identical material is used both in the OA cue and the NEXT cue.
If the same material is set in two consecutive cues, functions such as Play or 
Shot Recall of Camera will operate again from the beginning with the TAKE 
operation. To use the same material without repeating those operations, use 
this Icon.  

Example 1: When you want to make a Key On setting using a 
TAKE operation

In the above example, the Key On setting is set with a TAKE operation and 
the CG1 is superimposed on the DDR image. Playback of the DDR image 
continues in the next cue. 

Example 2: When you want to adjust the audio level using a TAKE 
operation

In the above example, the audio level is reduced with a TAKE operation while 
switching cues. Playback of the audio file continues in the next cue.

• PO Server
Video and Audio Icons for which class is designated as PO Server.
There are two types of PO Server Icons supplied by the system: one for all the 
channels and the other for a single channel. To display the Icon in a playlist, 
an Icon should be created for each channel. 
When the PO Server category is selected in the Cue Edit, the Icon the system 
supplies for all the channels is displayed. When the Icon is actually pasted in 
the NRCS client window and the channel is set, the icons the user has created 
for each channel are displayed in the playlist. 

Categories
The Icon Manager allows you to create categories to be used to classify Icons. 
Categories are created to narrow down the Icons to be displayed in the Cue Edit 
window, so that you can select an appropriate Icon easily.  
The icons of the following classes will be automatically allocated to the relevant 
class categories when their category types are specified. 

• Icons classified as DDR(VCDP) or Audio Server that show file lists by 
selecting a category.

• Icons classified as PO Server or Continuous that are supplied by the system.
Overview of Icons
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Workflow for creating icons and categories
The following provides an overview of the workflow for creating icons and 
classifying icons into categories:

Create an Icon by clicking [Create New] in the Icon Library.

See “Creating Icons”  (page 69).

m

Create a category by clicking [Create New] in the Category List.

See “Creating Categories”  (page 81).

m

Select a category registered in the Category List, select an Icon 
that you want to register in the Icon List, and then click [ADD] to 

add an icon to the category.

See “Registering an Icon in a Category”  (page 87).
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Starting the Icon Manager Application

Before you start the Icon Manager
To create Icons in the Icon Manager, the following preparations are necessary:

• Building up the database
In the database (SQL), tables, including Device Resources and Device 
Candidates, should be created. Without these settings, options such as Class 
and Device are not displayed in the Icon Manager. 

• Creating graphic data for thumbnails
In the Icon Manager, Icons are displayed graphically using the prepared 
graphic data.

• Creating snapshots with the video switcher
The Icon Manager reproduces transition, key, and other video effects by 
recalling snapshots, so snapshots should be prepared in advance.

• Creating a macro with the video switcher
Some types of transitions, such as CG Wipe, can use a macro of the video 
switcher, so macros should be prepared in advance.

1 Double-click the Icon Manager icon on the Windows desktop.
Or, double-click the IconManager.exe file in the “Sony\ELC\IconMgr” 
folder on the drive where the ELC-MVS01 software is installed.

The Icon Manager starts and the Icon Manager window is displayed.

 

Only one Icon Manager application can be operated in a system at a time. If the 
Icon Manager application is already operating on the same computer, or on a 
different computer in the system, you cannot start the application.

Exiting the Icon Manager Application

1 Click [File] > [Exit] from the menu bar of the Icon Manager Main Menu.

If there is an unsaved operation, the Icon Manager application asks you 
whether you want to save it. Save it if necessary. The Icon Manager 
application is closed.

Note
Starting the Icon Manager Application



  C
hapter 4  P

reparing Icons (Icon M
anager)
Managing Icons

This section explains how to create and set in detail an icon. You can also edit 
or delete a created icon.

Creating Icons

This section explains how to create an Icon, an element for creating a cue. 

For details of each Icon settings, see “Setting Icons”  (page 70).

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager.

The window for the selected tab is displayed.

2 Click [Create New] on the Icon Library. 
Or, right-click on the Icon Library, and select [Create New] from the menu 
displayed.

The Icon creation window is displayed.

Icon preview
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3 Input the desired name of up to 8 alphanumeric characters in the Icon Name 
text box.

The input name appears under the Icon thumbnail of the Icon preview block.

4 Click [Ref.] next to the Thumbnail box to display the image list contained 
in the relevant Windows folder. Then select the desired image for the 
thumbnail.

It is recommended that you use a graphic (jpeg/bmp) file displayed at 80 x 
45 pixels. 

Sample icon graphic files from Sony are supplied free for your use in the 
“Sony\ELC\BitmapIcon”  folder on the drive where the ELC-MVS01 
software is installed. 

5 Make the required settings to create a new Icon.

For details, see “Setting Icons” on page 70.

6 Click [OK].

The selected Icon window is closed and the Icon Manager window is 
displayed again. The created Icon is added to the end of the Icon Library.

Setting Icons

Video Icons  
You can create and edit Video Icons in the Video Icon window. 

1 Select the class where the desired device is classified from the Class drop-
down list box.

You can select from the following options. According to the class selected 
here, the rest of the menus show different options. 

Tip

Icon preview
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You can set the Class only when you are creating a new Icon. When you edit 
an existing Icon, the Class boxes are disabled.

2 Select the desired device from the Device drop-down list box. 

You can select from the devices of the selected class as follows. Depending 
on the class you have selected in step 1, the type of devices differs.

3 When you select [Camera] for the Class in step 1, specify the Camera 
Control options.

Class Descriptions

Camera Select this option to create a camera Icon.

CG/Still Store Select this option to create a CG or Still Store Icon. 
Tip
The CG/Still Store is a server having a playlist 
function. The CG/Still Store controller type with a 
playlist function and a storage type can be a different 
device. The ELC-MVS01 does not control the CG/Still 
Store and does not perform file operations. With the 
tally Off signal from the switcher, next piece of 
material on the playlist will be loaded for standby.

DDR(VDCP) Select this option to create a DDR(VDCP) Icon.
Tip
A disk recorder without a playlist function is 
supported. It handles frequently-used daily materials. 
You can specify files from the ELC-MVS01.

DDR(SonyVTR) Select this option to create a DDR(SonyVTR) Icon. 
Use this option for a digital disk recorder that can be 
controlled by the Sony VTR protocol.

Ext/Others Select this option to create a Color Background or 
Re-Entry Icon within the switcher. 

Frame Memory Select this option to specify a Frame Memory Icon 
within the switcher. 

PO Server Select this option to create a playout server Icon.
Tip
A playout server is a server having a playlist function. 
It handles daily-changing materials. The playout 
server controller type with a playlist function and a 
storage type can be a different device. The ELC-
MVS01 controls the playback function only and does 
not select files. When a file is played to the end, the 
next piece of material on the playlist will be loaded 
automatically for standby. 

Remote Select this option to create a remote Icon.

Note

Class You can select:

Camera Devices classified as camera in the database.

CG/Still Store Devices classified as CG/Still Store in the database. 

DDR(VDCP) Devices classified as DDR(VDCP) in the database. 

DDR(SonyVTR) Devices classified as DDR(SonyVTR) in the database. 

Ext/Others Devices classified as Ext/Others in the database.

PO Server Devices classified as PO Server in the database.
Select this option to create a PO Server Icon for each 
playout server channel.

Remote Devices classified as Remote in the database.
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Check either the Manual or Auto option box:

• Manual: Select this option to control the switcher’s cross point selection 
only, and to control the camera manually. 

• Auto: Select this option to control both the switcher’s cross point 
selection and to perform automatic control (Shot Recall) over the robotic 
camera. 
When you select Auto, the Show and Shot boxes become enabled. 
Proceed with the settings as follows:

Audio Icons  
You can create and edit Audio Icons in the Audio Icon window. 

 

The Audio Icons classified as CG/Still Store, DDR(VDCP), DDR(SonyVTR), 
PO Server, and Remote will be created automatically when a Video Icon is 
created. 

For details, see “List of Required Settings in Icon Creation and Category 
Registration” on page 89.

1 Select the class where the desired device is classified from the Class drop-
down list box.

You can select from the following options. According to the class selected 
here, the rest of the menus show different options. .

You can set the Class only when you are creating a new Icon. When you edit 
an existing Icon, the Class boxes are disabled.

Options Descriptions

Show Click the down arrow to display the Show options of 
the selected Device. Select the desired show option.  

Shot Click the down arrow to display the Shot options of 
the selected Show. Select the desired shot option.

Import button Click the button to re-load the Show/Shot information 
from the robotic camera.

Note

Class Descriptions

Audio Server Select this option to create an audio server Icon. 

Ext/Others Select this option to create a piece of material Icon for 
which the device control is not required.

Note

Icon preview
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2 Select the desired Device for the Icon from the Device drop-down list box. 

You can select from the following options. Depending on the class you have 
selected in step 1, the type of devices differs.

Transition Icons  
You can create and edit Transition Icons in the Transition Icon window. 

1 Select the class where the desired device is classified from the Class drop-
down list box.

You can select from the following options. According to the class selected 
here, the rest of the menus show different options. 

1) The option cannot be used for a key.
2) The option can be used only for a key.

Class You can select:

Audio Server Devices classified as audio server in the database.

Ext/Others Devices classified as Ext/Others in the database.

Class Descriptions

Mix Select this option to create a Mix icon.

NAM 1) Select this option to create a NAM icon.

Super Mix1) Select this option to create a Super Mix icon.

Wipe Snapshot1) Select this option to create a Wipe Snapshot icon.

DME Wipe Snapshot1) Select this option to create a DME Wipe Snapshot icon.

User Programmable 
DME

Select this option to create a User Programmable 
DME icon.

Resizer DME Wipe2) Select this option to create a Resize DME Wipe icon. 

Macro Select this option to create a Macro icon.

Preset Color Mix1) Select this option to create a Preset Color Mix icon.

Icon 
preview
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You can set the Class only when you are creating a new Icon. When you edit 
an existing Icon, the Class box is disabled.

2 Depending on the class you select in step 1, set the following options.

❐ When Wipe Snapshot or DME Wipe Snapshot is selected as 
Class

❐ When Mix, NAM, Super Mix, User Programmable DME, 
Resizer DME Wipe, or Preset Color Mix is selected as Class

❐ When Macro is selected as Class

Note

Options Descriptions

Pattern No. This option is disabled.

Direction This option is disabled. Register setting of this 
option in the Wipe Snapshot or DME Wipe 
Snapshot settings in advance.

Snapshot No. Select the Wipe Snapshot or DME Wipe Snapshot 
number from 1 to 10 from the drop-down list box. 

Number of DME CH Select the DME channel number the Icon uses from 
0 to 4. 

Macro This option is disabled.

Options Descriptions

Pattern No. Input the desired  pattern numbers to be enabled 
depending on the class you selected:
Resizer DME Wipe:
• 7001 to 7008
• 7021 to 7031
• 7201 to 7208
• 7221 to 7224
User Programmable DME:
• 1901 to 1999 (pattern using 1CH DME)
• 2901 to 2999 (pattern using 2CH DME)
• 3901 to 3999 (pattern using 3CH DME)

Direction Select either Normal or Reverse. You can set this 
option when User Programmable DME or Resizer 
DME Wipe is selected.

Snapshot No. This option is disabled.

Number of DME CH This option is disabled. 

Macro This option is disabled.

Options Descriptions

Pattern No. This option is disabled. Register the setting of this 
option within the Macro.

Direction This option is disabled. Register the setting of this 
option within the Macro.

Snapshot No. This option is disabled. Register the setting of this 
option within the Macro.

Number of DME CH Select the DME channel number the Icon is to use 
from 0 to 4. 

Macro This option is displayed only when Macro is selected 
for class.  Set the following in the Macro block:
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Macro No. Click the down-arrow to display the options list, and 
select the desired Macro number from 1 to 99.

Macro 
Transition Rate

Click the down-arrow and select a transition rate as 
long as or longer than that set for the Macro:

1(SS:FF) Transitions in the period set as  “1” in the Initial Setup 
application.

2(SS:FF) Transitions in the period set as “2” in the Initial Setup 
application.

3(SS:FF) Transitions in the period set as “3” in the Initial Setup 
application.

4(SS:FF) Transitions in the period set as “4” in the Initial Setup 
application.

Next Start 
Delay

When the transition delay macro is set, click the 
down-arrow to display the options list, and select the 
desired delay in play (start) to the Next Transition 
display from 0 to 999 frames. Without a delay, the 
Next Transition image will be displayed as soon as 
the play starts. 

(Example: when the Next Transition B is delayed)
Without a delay:

Options Descriptions

With a delay:

R
Play starts

R
Play starts
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Effect Icons  
You can create and edit Effect Icons in the Effect Icon window.  

1 Select the class where the desired device is classified from the Class drop-
down list box.

You can select from the following options. According to the class selected 
here, the rest of the menus show different options. 

You can set the Class only when you are creating a new Icon. When you edit 
an existing Icon, the Class box is disabled.

2 In the Snapshot Settings block, set the snapshots you will use in the Effect 
Icon.

Icon 
preview

Class Descriptions

SPE Select this option to create a Special Effect icon that 
allows you to perform picture effects using a 
snapshot. In addition to simple picture effects, you 
can register more complicated settings such as 
manual switching of multiple snapshots while on the 
air (2box), or manual switching of the bus between 
random materials while on the air. 
For details, see “Preparing for Switching Multiple 
Snapshots Manually (2Box)” on page 108.

Note
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For using multiple snapshots, you must make the required necessary 
settings in the Snapshot Settings block: the Standby Group#, Group Item 
Selection, and Group Name. 

For detailed settings, see “Preparing for Switching Multiple Snapshots 
Manually (2Box)”  (page 108).

3 In the Manual Switching block, set the manual switching you will use in the 
Effect Icon.

For details, see “Preparing for Manual Switching”  (page 113).

Setting in the source window
The Source window allows you to change the source settings of the bus. 

1 Double click on the desired thumbnail in the Bus Settings block on the 
Effect Icon window.

Options Descriptions

Number of Snapshot 
Groups

Select how many Snapshot Groups should be used, 
from 1 to 4 from the drop-down list box. 
A Snapshot Group represents a combination of 
snapshots, which you can recall by pressing the 
button assigned to a Snapshot Group on the shot box 
module. To recall one Snapshot Group, the number 
should be “1.” To recall multiple Snapshot Groups, 
select 2 to 4, corresponding to the number of 
Snapshot Groups that you want to recall.

• When “1” is selected:
Example: One snapshot is used and camera and 
CG are mixed. 

Group Item Put a check mark next to the places where you want to 
use Snapshots, and then select a snapshot number 
from the drop-down list box.

Number of DME CH Input the number of DME to be used in the Icon. 
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 The Source window of the selected bus is displayed.

2 Select whether you will use the bus image in performing effects. 

• Not Demand: Select this option when you do not want to use the bus 
image. When you set an image in Cue Edit, you will not be prompted to 
select a Bus image.

•

• Demand: Select this option to use the Bus image in the image mix effect. 
When you set an image in Cue Edit, you will be prompted to select an 
image for the Bus.

3 Input the desired bus name of up to 8 alphanumeric characters in the Bus 
Name text box.

4 Click [OK].

The settings take effect. The Source window is closed. The Effect Icon 
window is displayed again. 
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5 Select the desired bus in the Bus Settings block, and repeat steps 2 through 
4 to make the settings.

All the available buses to be used with the switcher are displayed. To change 
the settings, double-click on the thumbnail display block on the bus to 
display its source window.

Editing Icons

This section explains how to edit the settings of an Icon.

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager.

The window for the selected tab is displayed.

2 Click the desired Icon in the Icon Library, and click [Edit].
Or, right-click on the desired icon in the Icon Library, and select [Edit] from 
the menu displayed.

The Icon setting window is displayed.

You cannot edit an Icon in the Icon List.

3 Perform the desired settings.

For details, see “Setting Icons”  (page 70).

4 Click either of the two to execute the settings.

• Save: Saves the settings, overwriting the existing Icon. The Icons in the 
Icon List is updated, reflecting the changes.
When saving is complete, the [Save] button becomes disabled.

• Save as: Adds a new Icon to the Icon Library.

Display examples Descriptions

The A bus is used. The bus name is displayed 
if it is specified. In the Cue Edit window, you 
will be prompted to select a Video Icon.

The A bus is not used. A bus name will not be 
displayed even if it is specified. Instead, Not 
Demand is displayed.

The A bus is used. The bus name is displayed 
if it is specified. Manual Switching is 
associated with the A bus.

Note
79Managing Icons



80

  C
hapter 4  P

reparing Icons (Icon M
anager)
Deleting Icons

This section explains how to delete an Icon from the Icon Library.

• When you delete an Icon belonging to a category in the Icon Library, the Icon 
will also be deleted from the category.

• Once an Icon is deleted, you cannot select it when creating a new cue. Even if 
it has already been used in an existing cue, you can still continue to use the 
Icon.

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager.

The window for the selected tab is displayed.

2 Click the desired Icon in the Icon Library, and click  [Delete].
Or, right-click on the desired icon in the Icon Library, and select [Delete] 
from the menu displayed.

A confirmation dialog box is displayed.

3 Click [OK|.

The Icon is deleted from the Icon Library.

Notes
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Managing Categories

This section explains how to create and set in detail a category for classifying 
icons. You can also edit, move or delete a created category.

Creating Categories
This section explains how to create categories to store Icons.

For details of each category setting, see “Setting Categories”  (page 82).

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager.

The window for the selected tab is displayed.

2 Click [Create New] in the Category List.
Or, right-click on the Category List, and select [Create New Category] from 
the menu displayed.

The category setting window is displayed.

Category 
list

Icon Library
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3 Click the Category Name text box to make the box in the input mode.

4 Input the desired name of up to 25 alphanumeric characters in the Category 
Name text box.

5 When you create a Video or Audio category, select the desired category 
type from the Category Type drop-down list box.

According to the category type selected here, the Icons are automatically 
selected and displayed in the Cue Edit window when you select a category.

• Once you select a category type, the relevant Icons are automatically 
selected and displayed in the Icon Library. You cannot register an Icon in 
the Icon Library manually.

• For Transition and Effect categories, category type setting is not 
necessary.

For details, see “Setting Categories”  (page 82)

6 Click [OK].

The category is added to the end of the Category List.

Setting Categories

When you create a category, you can select the following category types:

To create a category for free registration
This category is used to register Icons freely.  (For Audio and Video Icons)
To create a category, select Blank for the category type(1).

.

In the Icon Library (2), nothing is displayed. Setting an icon here is not 
necessary. 
When this type of category is selected in Cue Edit window, user-registered 
Icons are displayed.

Notes

Category name

Category type

Icon library
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To create a category designed for PO (Playout) Server: 
This category is used to contain Icons classified as PO Server. (For Video and 
Audio Icons) 
To create a category for PO Server, select PO server for the category type (1).

In the Icon Library (2), nothing is displayed. 
In the Icon preview, video and audio Icons whose class is PO Server supplied 
by the system will be displayed automatically (3). No setting an icon is 
necessary. 
When this type of category is selected in Cue Edit, the PO Server icons for all 
channels prepared by the system are displayed.

To create a category designed for DDR(VDCP) 
This category is used to contain the files of the devices whose class is 
DDR(VDCP). (For Video Icons)
To create a DDR(VDCP) category, select DDR(VDCP) for the category 
type(1).

Category name

Category type

Icon library

Icon preview

Category name

Category type

Icon library 
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In the Icon Library(2), Icons classified as DDR(VDCP) are displayed. Select 
the Icon whose registered file list you want to use (3). To delete the setting, 
click [Delete] (4) next to the Icon preview.

To create a category designed for Audio Server
This category is used to contain the files of the devices whose class is Audio 
Server. (For Audio Icons)
To create an Audio Server category, select audio server for the category type 
(1).

.

In the Icon Library (2), Icons classified as Audio Server are displayed. Select 
the Icon whose registered file list you want to use (3). To delete the setting, 
click [Delete] (4) next to the icon preview.

To create a category designed for Continuous 
This category is used to contain the Continuous icons. (For Audio and Video 
Icons)
To create a Continuous category, select Continuous for the category type (1).

Category name

Category type

Icon library 

Category name

Category type

Icon preview

Icon library 
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In the Icon Library (2), nothing is displayed. 
In the Icon preview (3), Video and audio Icons whose class is Continuous 
supplied by the system will be displayed automatically. No settings on the icon 
are necessary. 
When this type of category is selected in Cue Edit, the Continuous icons 
supplied with the system are displayed.

Editing Categories

This section explains how to change the category settings.

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager.

The window for the selected tab is displayed.

2 Click the desired category in the Category List, and click [Edit].
Or, right-click on the desired category in the Category List, and select [Edit] 
from the menu displayed.

The category setting window is displayed.

3 Perform the required settings.

For details, see the steps 3 through  5  of “Creating Categories”  (page 81).

4 Click [OK].

The settings take effect. The Category List reflects the changes.
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Moving Categories

This section explains how to move a category within the Category List.

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager window.

The window for the selected tab is displayed.

2 Drag the desired category and drop it to the desired position in the Category 
List.

The category is moved.

Deleting Categories

This section explains how to delete a category from the Category List.

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager window.

The window for the selected tab is displayed.

2 Click the desired category in the Category List, and click  [Delete].
Or, right-click on the desired category in the Category List, and select 
[Delete] from the menu displayed.

A confirmation dialog box is displayed.

3 Click [OK|.

The category is deleted from the Category List.
Managing Categories
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Registering an Icon in a Category

This section explains how to register an Icon in a category. By categorizing 
Icons, you can display necessary Icons in the Cue Edit window, making Icon 
selection easier. 

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager window.

The window for the selected tab is displayed.

2 Click the desired category in the Category List.

The Icons currently registered in the category appear in the Icon list.

3 Click the Icon that you want to add to the category in the Icon Library.

To search for an Icon in the Icon Library
You can locate a desired Icon by using the search function of the window.
1 Check the desired check box from Name, or  Class that you want to use 

for searching for Icons. 
2 When you select Name, enter the desired Icon name in the text box. 

When you select Class, select the desired class from the list box.

For the details of Class, see explanations of each icon in “Setting 
Icons”  (page 70).

3 Click [Search].
The Icons found are added to the Icon Library. 

4 Click [ADD].

The selected Icon is registered to the category and added to the end of the  
Icon List.

Icon List

Search block
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• Once an Icon is registered in a category, you cannot move it to another 
category. To register the identical Icon to another category, add it from the 
Icon Library.

• You cannot add an Icon to a category whose category type is specified.

Moving an Icon within a Category

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager window.

The window for the selected tab is displayed.

2 Click the desired category in the Category List.

The Icons currently registered in the category appear in the Icon List.

3 In the Icon List, drag an Icon and drop it to the desired position.

The Icon is moved.

Deleting Icons from a Category

This section explains how to delete an Icon from a category. In this case, the 
Icon itself is not deleted, so the same Icon in another category or in the Icon 
Library is not deleted. 

You cannot delete an Icon from a category whose category type is specified.

1 Click the desired tab, Video, Audio, Transition, or Effect, in the Icon 
Manager.

The window for the selected tab is displayed.

Notes

Note

Icon List
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2 Click the desired category in the Category List.

The Icons currently registered in the category appear in the Icon list.

3 Click the desired Icon in the Icon List, and click  [Delete].
Or, right-click on the desired Icon in the Icon List, and select [Delete] from 
the menu displayed.

A confirmation dialog box is displayed.

4 Click [OK|.

The Icon is deleted from the Icon List.

List of Required Settings in Icon Creation and Category Registration

Depending on the type or class of an Icon, the following settings are required in 
creation, classification, and categorization.

Icons type Class Creating an Icon Creating a category Registering an 
Icon in a category

Video Camera An Icon should be created for each 
Video input.

You can create categories 
freely.

Required

CG/Still Store An Icon should be created for each 
Video channel.

You can create categories 
freely.

Required

DDR(VDCP) An Icon should be created for each 
Video channel.

Category type should be 
specified.

Not required

DDR(SonyVTR) An Icon should be created for each 
Video input.

You can create categories 
freely.

Required

Continuous Not required. The Icon is supplied by 
the system.

Category type should be 
specified.

Not required

Ext/Others An Icon should be created for each 
Video input.

You can create categories 
freely.

Required

Frame Memory An Icon should be created for each 
Video input.

You can create categories 
freely.

Required

PO Server An Icon should be created for each 
Video input.

Category type should be 
specified.

Not required

Remote An Icon should be created for each 
Video input.

You can create categories 
freely.

Required

Audio Audio Server An Icon should be created for each 
Audio input.

Category type should be 
specified.

Not required

CG/Still Store Not required. An Icon is created 
automatically with the Video Icon.

You can create categories 
freely.

Required

DDR(VDCP) Not required. An Icon is created 
automatically with the Video Icon.

You can create categories 
freely.

Required

DDR(SonyVTR) Not required. An Icon is created 
automatically with the Video Icon.

You can create categories 
freely.

Required

Continuous Not required. The Icon is supplied by 
the system.

Category type should be 
specified.

Not required

Ext/Others An Icon should be created for each 
Audio input.

You can create categories 
freely.

Required

PO Server Not required. An Icon is created 
automatically with the Video Icon.

Category type should be 
specified.

Not required

Remote Not required. An Icon is created 
automatically with the Video Icon.

You can create categories 
freely.

Required
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Transition Mix Icon creation is required. You can create categories 
freely.

Required

NAM

Super Mix

Wipe Snapshot

DME  Wipe 
Snapshot

User Programmable 
DME

Resizer DME Wipe

Macro

Preset Color Mix

Effect SPE Icon creation is required. You can create categories 
freely.

Required

Icons type Class Creating an Icon Creating a category Registering an 
Icon in a category
Registering an Icon in a Category
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5Preparing Cues
(ELC Plug-in)
Starting the ELC Plug-in Application

The ELC Plug-in application, working as a plug-in application for the NRCS 
client window, allows you to create and edit a cue. By registering a frequently-
used scene as a cue, you can improve the efficiency of playlist creation. The 
ELC Plug-in application provides the following two applications:
• Quick Cue: Allows you to create a cue by registering the settings of 

frequently-used scenes.
• Cue Edit: Allows you to edit a cue created in Quick Cue. 

1 Start the NRCS client window.

2 Depending on the NRCS client software you use, start the ELC Plug-in 
application as follows:

• iNEWS: Click [Tools ] > [Plug-in] > [ELC Plug-in] from the menu bar.
• ENPS: Click the rover (green dot) of the Media Control icon on the 

bottom bar of the ENPS client window, and select [ELC Plug-in] from the 
displayed menu. 

The ELC Plug-in window is displayed. (The window below is the iNEWS 
window.)
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You can start as many ELC Plug-in applications simultaneously on different 
computers as the number of licenses you have. 

Exiting the ELC Plug-in Application

1 Click  on the upper right of the ELC Plug-in window.

The ELC Plug-in application is closed.

 

If you do not save the settings, the revisions do not take effect.

Tip

ELC Plug-in window

Note
Starting the ELC Plug-in Application
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Managing Cues

This section explains how to create a cue, setting its details, move or delete a 
cue, or copy a cue.

Creating a Cue

This section explains how to create cues to be used in a playlist. 
If there is no folder to contain cues, first create a folder.

For details, see “Creating a Cue Folder”  (page 106). 

1 Click the Quick Cue tab of the ELC Plug-in window.

The Quick Cue window is displayed.

2 From the cue folder list, click the folder in which you want to create and 
save a new cue. 

The cues contained in the folder are displayed.

3 Right-click on the blank space of the cue list block, and click [Create New 
Cue] from the menu displayed.

The Rename dialog box is displayed.

4 Input the desired name of up to 8 alphanumeric characters for a cue.

5 Click [OK].

A new cue is created at the end of the cue list.

6 Right-click on the new cue, and click [Edit] from the menu displayed.

The Cue Edit window is displayed. The new cue is loaded into the window 
as the current cue.
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7 Make the required settings for a new cue.

For details, see “Details of Settings” below.

To delete Icons in the Cue Edit window
You can delete an Icon in the list of the settings to be changed and current cue.

1 Right-click on the Icon that you want to delete, and select [Delete] from 
the menu displayed.
A confirmation dialog box is displayed.

2 Click [OK].
The Icon is deleted in the list of the settings to be changed and current 
cue. 

8 Click [Save].

current cue
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Details of Settings

Setting Effect
You can set an Effect Icon in a new cue or an existing cue being displayed as 
the current cue in the Cue Edit window.  

1 Click the Video Icon display block in the current cue. 

2 Click the desired category in the category list.

In the category list, the effect categories created in the Icon Manager are 
displayed. 
When a category is selected, the Icons  in the selected category are displayed 
in the Icon list.

3 Select the desired Icon in the Icon list.

The Icons classified in the effect category are listed. 
When you select an Icon, the detailed settings block is updated to show the 
items for the selected Icon.

For selecting a Video Icon for each bus displayed on the list of the settings to 
be changed, follow the procedures described in “Setting Video”  (page 95).

For each Key detailed settings, follow the procedures described in “Setting 
Keys”  (page 98).

Setting Video
You can set a Video Icon in a new cue or an existing cue being displayed as the 
current cue in the Cue Edit window. 

1 Click the Video Icon display block in the current cue. 

2 Click the desired bus in the list of the settings to be changed.

3 Click the desired category in the category list.

In the category list, the video categories created in the Icon Manager are 
displayed. 
When a category is selected here, the Icons in the selected category are 
displayed in the Icon list.

Video Icon display block in the current cue

Detailed settings
95Managing Cues



96

  C
hapter 5  P

reparing C
ues (E

LC
 P

lug-in)
4 Select the desired Icon in the Icon list.

The selected Icon is displayed in both the current cue and the list of settings 
to be changed.

5 Depending on the settings made in previous steps, change the detailed 
settings.

❐When you select a Video Icon classified as DDR(SonyVTR) 
in step 3
A detailed block for setting the IN point is displayed. Specify the IN point 
of the video materials. Select the desired time codes from the drop-down 
list boxes for the IN point in the HH:MM:SS:FF format. 

Category type Descriptions

Continuous The Continuous icons supplied by the system are 
displayed. 
For details, see “Continuous” on page 66.

DDR(VDCP) DDR(VDCP) files registered in the file list with the Initial 
Setup are displayed. 

PO Server PO Server icon for all the channels supplied by the system 
are displayed. 
Tip
Do not specify files, but select  a PO Server icon for all 
channels only. The channel will be assigned on the NRCS 
client window. 

Others The Icons registered in the selected category are 
displayed.

Option Descriptions

HH 00 - 23

MM 00 - 59

SS 00 - 59

FF 00 - 29 or 00 - 24 depending on the system you are using.

File list
List of the 
settings to be 
changed

Video Icon display block in the current cue
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❐When you select bus A or bus B in step 2
A block for setting Side Flag is displayed. If necessary, make the Side 
Flag settings. 

• To change the Side Flag settings for the NEXT Cue just before the on-
air operation, you can execute the Side Flag function by assigning it to 
the Shot Box Module. This change in the settings on the Shot Box 
Module, however, is not reflected in the Cue Edit window.
For details, see “Assigning Functions to the Shot Box Module Buttons” 
on page 54

• When you want to use the same Util1 image without changing it for 
cues, use the Initial Snapshot setting.

• When you use the Side Flag function for a cue where  multiple 
snapshots (2box) or manual switching is specified, the Side Flag 
function may not work properly when switching as specified in the Cue 
Edit window. Make sure to arrange a rehearsal in advance.

• For inputs where you may activate the Side Flag function, set the video 
switcher so that the aspect ratio is 4:3. When you set the aspect ratio to 
16:9, you cannot add the Side Flags even if the the Side Flag function 
is set to On in the Cue Edit window.

Option Descriptions

On Enables the Side Flag function. At both sides of a 4:3 source 
image,  Util1 images are displayed so that the aspect ratio of the 
image becomes 16:9.

Off Disables the Side Flag function. The input image is used as it is.

Tips

Notes

In point settings

5  Side Flag settings
97Managing Cues



98

  C
hapter 5  P

reparing C
ues (E

LC
 P

lug-in)
❐When you select a Camera Icon for which the Shot Recall is 
set in step 4
A block for setting the Move for Shot Recall of Camera is displayed. If 
necessary, adjust the speed by setting the Move duration. 
To enable the Move function for Shot Recall with the TAKE operation, 
put a check mark in the Move check box. Then select the desired duration 
for moving the current camera position to the next position for the next 
shot in the SS:FF format: 

When you want to specify the start point for moving in advance, create a 
cue where the start point is specified before the cue with the Move setting.

Setting Keys
Key is automatically set to On. (Key Off setting is not available.)

1 Click the Key display block in the current cue. 

The Key Bus icon is being selected on the list of settings to be changed.

2 Click the desired category in the category list.

Option Descriptions

SS 00 - 59

FF 00 - 29 or 00 - 24 depending on the system you are using.

Note

Move for Shot Recall 
settings

Key display block in the current cue

List of the 
settings to be 
changed
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When a category is selected here, the Icons in the selected category are 
displayed in the Icon list.

3 Select the desired Video Icon in the Icon list.

4 Click the desired Key Bus display block in the second layer on the list of the 
settings to be changed.

5 Click the desired category in the category list.

In the category list, the transition categories created in the Icon Manager are 
displayed. 
When a category is selected, the Icons in the selected category are displayed 
in the Icon List.

6 Select the desired Icon in the Icon List.

The Icons classified in the transition category are listed.

7 Select the desired transition rate from the drop-down list box in the 
Transition Rate block.

For details, see “Specifying the Transition Rate Options” on page 46.

Adjusting the keys
Set the key type (chrome key/luminance key) or adjust the key modifier with 
either of the following operations:
• Using the key memory of the video switcher
• Setting the type to the snapshot

Setting Audio
You can set an Audio Icon in a new cue or an existing cue being displayed as 
the current cue in the Cue Edit window. 

1 Click the audio channel display block in the current cue. 

The desired audio channel is being selected on the list of settings to be 
changed.

Option Descriptions

1(SS:FF) Transition in the period set as “1” in the Initial Setup application.

2(SS:FF) Transition in the period set as “2” in the Initial Setup application.

3(SS:FF) Transition in the period set as “3” in the Initial Setup application.

4(SS:FF) Transition in the period set as “4” in the Initial Setup application.

List of the settings 
to be changed
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2 Click the desired category in the category list.

In the category list, the audio categories created in the Icon Manager are 
displayed.  
When a category is selected, the Icons or the files in the selected category 
are displayed in the Icon list or in the file list. 

3 Select the desired Icon in the Icon list.

The selected Icon is displayed in both the list of settings to be changed and 
the current cue. The detailed settings is activated only when an Audio Icon 
or file is set for the selected audio number.

You cannot use the audio material of a DDR(VDCP) or DDR(SonyVTR) 
Icon separately, since DDR(VDCP) and DDR(SonyVTR) Icons are shared 
with a video. If you set the audio materials in an audio Icon, only XPT 
control of the audio mixer is available. To open a file, we recommend you 
set the audio materials in a video Icon.

4 If necessary, change the detailed settings.

Category type Descriptions

Audio Server Audio Server files  registered in the file list with the Initial 
Setup are displayed. 

PO Server PO Server icon for all the channels supplied by the system 
are displayed. 
Tip
Do not specify files, but select  a PO Server icon for all 
channels only. The channel will be assigned on the NRCS 
client window. 

Continuous The Continuous icons supplied by the system are displayed. 
For details, see “Continuous” on page 66.
Note
The Fade In/Fade Out  and Level settings are not retained, 
so you should make those settings for the NEXT cue.

Others The Icons registered in the selected category are displayed.

Note

Audio channel in the current cue

List of the 
settings to be 
changed

File list
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• Fade In: Specify the fade in time from the following options:  

• Fade Out: Specify the fade out time from the following options:  

• Level: Specify the desired audio level from the following options:  

           a) xx: The value specified in the Initial Setup window. 

• MIX−: Specify the desired port for MIX−.  This option is effective only 
when a piece of material classified as Remote is selected.

 

Depending on the audio mixer you are using, there may be restrictions on 
using the AUX Bus.

Setting Transition
You can set a Transition Icon in a new cue or an existing cue being displayed as 
the current cue in the Cue Edit window. 

1 Click the Transition Icon display block in the current cue.

The desired Transition Icon display block is being selected on the list of 
settings to be changed.

2 Click the desired category in the category list.

In the category list, the transition categories created in the Icon Manager are 
displayed. 
When a category is selected, the Icons in the selected category are displayed 
in the Icon list. 

Option Descriptions

0(SS:FF) Fade in zero second.

1(SS:FF) Fade in the period set as “1” in the Initial Setup application.

2(SS:FF) Fade in the period set as “2” in the Initial Setup application.

3(SS:FF) Fade in the period set as “3” in the Initial Setup application.

4(SS:FF) Fade in the period set as “4” in the Initial Setup application.

Option Descriptions

0(SS:FF) Fade out in zero second.

1(SS:FF) Fade out in the period set as “1” in the Initial Setup application.

2(SS:FF) Fade out in the period set as “2” in the Initial Setup application.

3(SS:FF) Fade out in the period set as “3” in the Initial Setup a location.

4(SS:FF) Fade out in the period set as “4” in the Initial Setup application.

Option Descriptions

3 (xx dB)a) The level set as “3” in the Initial Setup application is selected.

2 (xx dB)a) The level set as “2” in the Initial Setup application is selected.

1 (xx dB)a) The level set as “1” in the Initial Setup application is selected.

0 (–∞ dB) The level is set at –∞ dB.

Manual The mixer level at that point is selected.

Option Descriptions

Off MIX- is not be performed. 

AUX 1 − 
AUX16

Specify the port from AUX 1 to AUX 16. When outputting from the 
selected port, PGM OUT excluding the selected audio will be output.

Note
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3 Select the desired Icon in the Icon list.

The Icons classified in the transition category are listed. 

4 If necessary, change the detailed settings.

• Transition Rate: Specify the transition rate from the following options: 

For details, see “Specifying the Transition Rate Options” on page 46.

• BKGD/ALL: Select the transition region from the following options:  

Option Descriptions

1(SS:FF) Transition in the period set as “1” in the Initial Setup application.

2(SS:FF) Transition in the period set as “2” in the Initial Setup application.

3(SS:FF) Transition in the period set as “3” in the Initial Setup application.

4(SS:FF) Transition in the period set as “4” in the Initial Setup application.

Option Descriptions

BKGD Among the images composing a cue, only the background image 
will transition. 

ALL The whole image comprising of a cue will transition. Usually, use 
this option.

Transition Icon display block in the current cue

List of the settings to 
be changed
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Editing a Cue Registered in Quick Cue

This section explains how to edit a cue already registered on the Quick Cue 
window. 

1 Click the Quick Cue tab of the ELC Plug-in window.

The Quick Cue window is displayed.

2 From the cue folder list of the Quick Cue window, click the folder which 
contains the cue that you want to edit. 

The cues contained in the folder are displayed.

3 Right-click on the desired cue and select [Edit] from the menu displayed.

The Cue Edit window is displayed. The selected cue is loaded into the 
window as the current cue.

4 Make the required settings for the cue.

For details, see “Details of Settings”  (page 95).

To delete Icons in the Cue Edit window
You can delete an Icon in the list of the settings to be changed and current 
cue.

1 Right-click on the Icon that you want to delete, and select [Delete] from 
the menu displayed.
A confirmation dialog box is displayed.

2 Click [OK].
The Icon is deleted from the Cue Edit window. 

 Current cue
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5 Click either of the following two buttons to execute the settings.

• Save: Saves the settings, overwriting the existing Cue.

• Save as:  Opens the dialog box used to input a new name. 
Input a new name and click [OK] so that a new Cue is added to the end of 
the Cue list.

Renaming a Cue

This section explains how to rename a cue on the Quick Cue window. 

1 In the cue list block of the Quick Cue window, right-click the cue that you 
want to rename, and select [Rename] from the menu displayed.

The Rename dialog box is displayed.

2 Input the desired name of up to 8 alphanumeric characters for a cue.

3 Click [OK].

The cue is renamed and the Rename dialog box is closed.

Deleting a Cue

This section explains how to delete a cue on the Quick Cue window. 

1 In the cue list block of the Quick Cue window, right-click the cue that you 
want to delete, and select [Delete] from the menu displayed.

A confirmation dialog box is displayed. 

2 Click [OK].

The cue is deleted.
Managing Cues
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Moving a Cue within a Folder

This section explains how to move a cue so that the position it is displayed at 
changes within a folder. 

1 In the cue list block of the Quick Cue window, drag the desired cue and drop 
it in the desired position in the cue list. 

The cue is moved to the position where it was dropped.

 

You cannot select multiple cues at one time.

Copying a Cue to Another Folder

This section explains how to copy a cue to another folder in the cue folders block 
in the Quick Cue window. 

1 In the cue list block of the Quick Cue window, right-click the cue that you 
want to copy, and select [Copy] from the menu displayed.

2 From the cue folder list of the Quick Cue window, click the folder to which 
you want to copy the cue. 

The cues contained in the folder are displayed.

3 Right-click on the blank space of the cue list block, and select [Paste] from 
the menu displayed.

The cue is copied at the end of the cue list.

Note
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Managing Cue Folders

This section explains how to create cue folders so that you can classify cues and 
select appropriate cues easily when creating a playlist.

 

You cannot select multiple cue folders at one time.

Creating a Cue Folder

This section explains how to create a cue folder in the cue folder list in the left 
block of the Quick Cue window.

1 Right-click on any cue folder or on blank space of the cue folder list block, 
and select [Create New Folder] from the menu displayed.

The Rename dialog box is displayed.

2 Input the desired name of up to 25 alphanumeric characters for a cue folder.

3 Click [OK].

A new cue folder is created at the end of the cue folder list.

Renaming a Cue Folder

This section explains how to rename a cue folder in the Quick Cue window. 

1 In the cue folder list block of the Quick Cue window, right-click the cue 
folder that you want to rename, and select [Rename] from the menu 
displayed.

The Rename dialog box is displayed.

2 Input the desired name of up to 25 alphanumeric characters for a cue folder.

3 Click [OK].

The cue folder is renamed and the Rename dialog box is closed.

Note
Managing Cue Folders
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Deleting a Cue Folder

This section explains how to delete a cue folder in the Quick Cue window. 

1 In the cue folder list block of the Quick Cue window, right-click the cue 
folder that you want to delete, and select [Delete] from the menu displayed.

A confirmation dialog box is displayed. 

2 Click [OK].

The cue folder is deleted. The cues contained in the cue folder are also 
deleted.

Moving a Cue Folder

This section explains how to move a cue folder so that the position it is displayed 
at changes in the cue folder list. 

1 In the cue folder list block of the Quick Cue window, drag the desired cue 
folder and drop it at the desired position in the cue folder list. 

The cue folder is moved to the position where it was dropped.
107Managing Cue Folders
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Chapter6Preparing for Advanced 
Manual Operations
Preparing for Switching Multiple Snapshots Manually 
(2Box) 

This section explains how to prepare for an advanced on-air manual operation, 
switching multiple snapshots manually (2Box). This operation is useful to show 
images in a studio and at another location in 2-split screens, or show both 
images in full screen.
As in the example below, each or both of the images in two boxes can be 
recalled in full screen made alternately. To perform this operation, you must use 
three snapshots, each allocated to a button on the shot box module. By using the 
buttons on the shot box module, you can switch multiple snapshots during on-
air operations.
 

Preparing for Switching Multiple Snapshots Manually (2Box)
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Required Settings in the Icon Manager Application

This section explains how to create an Icon classified with SPE and set Snapshot 
in the Snapshot Settings block.   

1 In the Icon Manager window, create an Effect Icon and select [SPE] from 
the Class drop-down list box.

For details, see “Effect Icons” on page 76.

2 Set the number of Snapshot Groups in the Snapshot Settings block.

Specify the combination number of snapshots to be recalled by pressing the 
associated buttons on the shot box module. 
Select [3] from the Number of Snapshot Groups.

3 Select the Standby Group# in the Snapshot Settings block.

Select which snapshot will be loaded for standby, and recalled first when the 
relevant cue is taken on the air. 

4 Select the desired group from the Group Item Block drop-down list box.

For group selection, see “Required Settings in the Initial Setup 
Application” on page 110. 

5 For each group, check the places you use for Snapshots, select a snapshot 
number from the drop-down list box. 

6 Click the Group Name text box to make it in the input mode, and enter a 
group name up to 8 alphanumeric characters.

The name input here may appear on a button of the shot box module. 
109Preparing for Switching Multiple Snapshots Manually (2Box)
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• Although you can enter both capital and lower case letters here, the names 
will be shown in capital letters on the shot box module.

• Input a symbol “ | ” , so that a line break is inserted on the shot box 
module.

7 When you check DME CH 1 to 4 in step 5, select the maximum number of 
DME you check from the Number of DME CH drop-down list box.

For saving, see “Effect Icon Window” on page 30.

Required Settings in the Initial Setup Application

To switch multiple snapshots manually, you will use the shot box module and 
assign Snapshots to its buttons. This section explains how to assign the 
snapshots to the shot box module buttons. 

1 In the Initial Setup window, click the Shot Box Module Assign sub menu.

The Shot Box Module Assign window is displayed.

2 Select the tab corresponding to the bank to which you want to assign the 
functions.

The functions assigned to the buttons of the selected bank are displayed in 
the Assign List.

3 On the Function List, select Snapshot Group 1 through 4.

To select more than one function, hold down the Ctrl key, and click the 
desired functions.

Notes

Button layout
Preparing for Switching Multiple Snapshots Manually (2Box)
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To select all functions in a range, hold down the Shift key, and click the first 
and last functions in the range.

4 Select the number corresponding to the button to be assigned with the 
function on the Assign List.

Or, if you select more than one function in step 3, select the lowest number 
of the buttons to which you want to assign the functions. In this case, the 
functions will be assigned to the buttons of the selected and the subsequent 
numbers.

5 Click [CADD].

The selected function(s) are assigned to the button(s), and displayed on the 
Assign List.
In the Name column, the default name is displayed. You cannot edit the 
name. On the buttons on the shot box module, group names specified in the 
Effect Icon are displayed. 

For details, see “Required Settings in the Icon Manager Application”  
(page 109).

6 Click [Save] to save the modified settings.

Function Description

Snapshot Group 
1 - 4

Recall the snapshot specified as the Snapshot Group 1 to 
4. This option is set when you create an Effect Icon by 
pressing the shot box module buttons and recalling the 
combination of associated snapshots. 
For details, see “Required Settings in the Icon Manager 
Application” on page 109.
111Preparing for Switching Multiple Snapshots Manually (2Box)
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Required Settings in the ELC Plug-in Application

For example, to select source images for a video effect using two Keys, use the 
following procedure. 

1 In the Cue Edit window, click the Key 1 display block on the current cue.

The selected Key Icon is highlighted both in the current cue and the list of 
the settings to be changed. 

2 Click the desired category in the category list.

In the category list, the video categories created in the Icon Manager are 
displayed. 
When a category is selected, the Icons in the selected category are displayed 
in the Icon list. 

3 Select the Icon you created for switching multiple snapshots manually in the 
Icon list according to the purposes.

The video materials to be used will be identical for all the snapshots.

4 In the list of the settings to be changed, click the Key 2 icon.

5 Repeat steps 2 and 3 to select the video source for the Key 2.

For saving, see “Cue Edit Tab”  (page 36).

Note

Key1 display block on the  current cue
Preparing for Switching Multiple Snapshots Manually (2Box)
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Preparing for Manual Switching

This section explains how to prepare for an advanced on-air manual operation, 
manual switching. This function allows you to switch only a part of the images 
within a cue by using the buttons on the shot box module, each associated with 
a Video Icon. You can use up to 6 Video Icons and assign them to buttons of the 
shot box module.
As an example, shown below, you can switch images in the background inset 
screen only from one location or camera to another (PinP). 

Before performing the operations, follow the procedures below to make the 
required settings.

Required Settings in the Icon Manager Application

This section explains how to create an Effect Icon for manual switching.  

1 In the Icon Manager window, create an Effect Icon and select [SPE] from 
the Class drop-down list box.

You can create an Icon classified as SPE.

For details, see “Effect Icons” on page 76.

2 Select [1] from the Number of Snapshot Groups in the Snapshot Settings 
block.
113Preparing for Manual Switching
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3 Check the check box you use for Snapshots, then select a snapshot number 
from the drop-down list box.

4 When you check DME CH1 to 4 in step 3, select the maximum number of 
DME you check from the Number of DME CH drop-down list box.

5 Select [On] in the Manual Switching block.

The Manual Switching is set effective. You can switch up to 6 images by 
pressing the buttons on the Shot Box Module associated with Video Icons.

6 Select the desired M/E for switching images from the M/E drop-down list 
box.

7 Select the desired Bus from the Bus drop-down list box.

For saving, see “Effect Icon Window” on page 30.

Required Settings in the Initial Setup Application

This section explains how to assign materials to be used in manual switching to 
the shot box module buttons. 

1 In the Initial Setup window, click the Shot Box Module Assign sub menu.

The Shot Box Module Assign window is displayed.

2 Select the tab corresponding to the bank to which you want to assign the 
functions.

The functions assigned to the buttons of the selected bank are displayed in 
the Assign List.

3 Select Manual Switching 1 - 6 to be assigned on the Function List. 

Button layout
Preparing for Manual Switching
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To select more than one function, hold down the Ctrl key, and click the 
desired functions.
To select all functions in a range, hold down the Shift key, and click the first 
and last functions in the range.

4 Select the number corresponding to the button to be assigned with the 
function on the Assign List.
Or, if you select more than one function in step 3, select the lowest number 
of the buttons to which you want to assign the functions. In this case, the 
functions will be assigned to the buttons of the selected and the subsequent 
numbers.

5 Click [CADD].

The selected function(s) are assigned to the button(s), and displayed on the 
Assign List.
In the Name column, no name is displayed. You cannot edit names.

6 Click [Save] to save the modified settings.

Function Description

Manual 
Switching 1 - 6

Switches to the video signal of the 1 to 6 Video Icon listed 
for manual switching. 
For details, see “Required Settings in the ELC Plug-in 
Application”  (page 116).
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Required Settings in the ELC Plug-in Application

This section explains how to specify up to 6 pieces of materials to be used in 
manual switching. 

1 In the Cue Edit window of the ELC Plug-in application, click the Video Icon 
display block of the current cue.

If the Manual Switching has been set, the list of the subjects to be switched 
will be displayed in the second layer of the list of settings to be changed.

2 Select the subjects to be switched. 

Set the material to be used first in the on-air operation as the first of the 
subjects to be changed in manual switching.

3 Click the desired category in the category list.

4 Select an Video Icon in the Icon list.

The names of the Video Icons you select are displayed on the buttons of the 
shot box module.

5 Repeat steps 2 to 4 to specify multiple materials to be switched.

For saving, see “Cue Edit Tab” on page 36.

Video icon display block on the current cue
Preparing for Manual Switching
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Assigning a Video Switcher Macro to a Cue

You can register various settings in a video switcher macro and then assign the 
created macro to a cue. With the TAKE operation, the macro is recalled and 
executed. This section explains how to assign a macro to a cue.

1 In the Cue Edit window of the ELC Plug-in application, click the Video Icon 
display block of the current cue.

2 Click the Effect Icon on the list of the settings to be changed.

3 From the Macro Recall drop-down list box of the detailed settings block, 
select the macro that you want to recall.

Example: When you want to output and play a playout server image 
from an AUX bus
You can perform a mix transition from a cue where the camera image is 
displayed in full screen and playout server image in the inset screen of a cue 
where the playout server image is displayed in full screen. To perform this 
effect, a macro assignment to a cue is an effective method.

Function Description

Off Macro will not be recalled.

1 to 99 Select the Macro Register number you want to recall from 1 
to 99.

Screen you want 
to display

Tips on settings

Create a video switcher macro allowing a playout server image 
to be output and played from an AUX Bus. Then assign the 
created macro to a cue. Fix the Ch setting of the playout 
server.

m
Assign an Icon that specifies the identical cross point (video 
source) as the playout server of the previous cue.

Video icon display block on the current cue
117Assigning a Video Switcher Macro to a Cue
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This section explains how to create a playlist using the cues, based 
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7Creating a Playlist for 
iNEWS (ELC Plug-in/Playlist Viewer)
Starting the ELC Plug-in Application

The ELC Plug-in application, working as a plug-in application for the existing 
iNEWS client software, allows you to create a playlist by using the cues created 
in the ELC Plug-in’s Quick Cue and Cue Edit windows. 

- Editing a production cue registered in iNEWS
- Editing part of a cue in Quick Cue and setting it to iNEWS as a new 

production cue

1 Start the iNEWS client software.

2 Click [Tools ] > [Plug-in] > [ELC Plug-in] from the menu bar. 

The ELC Plug-in application starts and ELC Plug-in window is displayed.

 

You can start as many ELC Plug-in applications simultaneously on different 
computers as the number of licenses you have.

Tip

ELC Plug-in window
119Starting the ELC Plug-in Application
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Exiting the ELC Plug-in Application

1 Click  on the upper right of the ELC Plug-in window.

The ELC Plug-in application is closed.

 

If you do not save the settings, the revisions do not take effect.

Note
Starting the ELC Plug-in Application
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Creating a Playlist

This section explains how to create a playlist using the ELC Plug-in application. 
The created playlist will be displayed in the Playlist Viewer application. 

Creating a Playlist

This section explains how to create playlists using cues. Before starting creation 
of a playlist, prepare the cues in the Quick Cue and Cue Edit windows of the 
ELC Plug-in application.

For details on creating cues, see “Creating a Cue”  (page 93). 
For details on setting a cue, see “Details of Settings”  (page 95).

1 Click the Quick Cue tab of the ELC Plug-in window.

The Quick Cue window is displayed.

2 In the queue panel in the iNEWS client window, click the desired iNEWS 
story to which you want to add a cue from the ELC Plug-in application.

The selected story is displayed in the story panel of the iNEWS client 
window.

iNEWS story panel

Story form 
panel

Instruction 
panel

Story text panelCue is added as a new *ELC production cue. 
121Creating a Playlist
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3 From the cue folder list of the Quick Cue window, click the folder 
containing the cue that you want to add to a playlist. 

The cues contained in the folder are displayed.

4 Drag the desired cue from the Quick Cue window and drop it on the iNEWS 
story text panel.

An asterisk “*” appears at the position where the cue was dropped on the 
story text panel, and the new cue is described as an ELC production cue. In 
the instruction panel, “*ELC” followed by the cue name is also added.  A 
cue is always added as an “ELC production cue.”

5 Repeat steps 2 through 4 to add cues to the rundown.

To set a new production cue after checking the content of a cue
You can check the content of a cue and edit it, if necessary, before you actually 
add it to an iNEWS story as a new ELC production cue. 

1 In the queue panel on the iNEWS client window, click the desired iNEWS 
story to which you want to add a cue from the ELC Plug-in application.

The selected story is displayed in the story panel of the iNEWS client 
window.

2 Double-click on the desired cue in the cue list block of Quick cue.

The Cue Edit window is displayed. The selected cue is loaded into the 
window as the current cue. The registration icon appears on the current cue.

3 Check the content and change the settings, if necessary.

For details, see “Details of Settings”  (page 95).

4 Drag the registration icon from the Cue Edit window and drop it on the 
iNEWS story text panel.

An asterisk “*” appears at the position where the cue was dropped on the 
story text panel and the new cue is described as an ELC production cue. In 
the instruction panel, “*ELC” followed by the cue name is also added.  A 
cue is always added as an “ELC production cue.”

4 Registration icon
Creating a Playlist
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To display added cues in the Playlist Viewer and OA Playlist applications, you 
should save the story in the iNEWS window. When the focus moves over stories 
in the queue panel, stories are saved automatically. Otherwise, save the story by 
selecting [File] > [Save Story] from the iNEWS menu bar.

Rules in setting ELC production cues
• The ELC production cues to be included in the same ELC story on a playlist 

should have the same Page number. An ELC story consists of ELC production 
cues having the same Page number. 

• An ELC production cue should be placed before the production cue of the 
materials that the ELC cue uses.

• You can set multiple ELC production cues in an iNEWS story.

When using the PO server
To display the status of the playout server in a cue, you should make settings in 
the story form panel of the iNEWS client window. A story form panel is 
designed for one iNEWS story only. When you use multiple PO Servers in an 
ELC story, therefore, you should use multiple iNEWS stories to make settings 
for the PO Servers. According to the order where the PO Servers are set in the 
iNEWS story, you can associate the materials of the PO Servers with the  list of 
the settings to be changed for a video and audio channel on the ELC Plug-in 
application windows.

❐  Example 1) When using PO Servers in both Key 1 and Key 2 of a cue

To create the playlist shown above, create a cue, drag and drop a Production 
cue, and then make settings in the iNEWS stories as follows:

1 For the iNEWS story where an ELC Production cue has been pasted, 
make settings for the PO Server Key 1 uses.

Note

iNEWS story

ELC Production cue is pasted. Make settings in the Story Form Panel
123Creating a Playlist
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2 Insert a new iNEWS story, make settings for the PO Server Key 2 uses.

Make sure not to set an ELC production cue for this inserted iNEWS 
story.

The PO Server set in the first iNEWS story is used with the Key 1 bus, 
and that set in the next iNEWS story is used with the Key 2 bus.

❐ Example 2) When setting multiple ELC Production cues and PO 
Servers of an ELC story

To create the playlist shown above, create three cues as follows:
• *ELC1: A cue having no PO Server settings.
• *ELC2: A cue having PO Server settings with both Key 1 and Key 2.
• *ELC3: A cue having PO Server settings with Audio. 

Then set the above three cues for an identical iNEWS story as follows:

1 For the iNEWS story where the three ELC Production cues are set, 
make settings for the PO Server to be used first (the source for Key 1 
of *ELC2).

Inserted iNEWS story

Make settings in the Story Form Panel

*ELC1

*ELC2        *ELC3
Creating a Playlist
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2 Insert a new iNEWS story, make settings for the PO Server to be used 
second (the source for Key 2 of *ELC2). 

Make sure not to set an ELC production cue for this inserted iNEWS 
story.

3 Insert another iNEWS story, make settings for the PO Server to be used 
third (the source for the Audio of the *ELC3).

Make sure not to set an ELC production cue for this inserted iNEWS 
story.

iNEWS story

Three ELC Production cues are set. Make settings in the Story Form Panel

Inserted iNEWS story

Make settings in the Story Form Panel
125Creating a Playlist
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The ELC Plug-in application uses the ELC Production cues and PO 
Server settings in the order they are assigned in the iNEWS story, and 
associates a video bus or audio channel with the materials of the PO 
Server.

Editing an ELC Production Cue added to an iNEWS rundown

You can use Cue Edit to edit a cue that has been added to an iNEWS rundown 
and has been described as an ELC production cue.

1 In the iNEWS instruction panel, double-click on the  ELC production cue 
that you want to edit.

The selected cue is displayed as the current cue in the Cue Edit window.

Inserted iNEWS story

Make settings in the Story Form Panel

ELC production cue

Instruction 
panel
Creating a Playlist
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2 Make the required settings for the cue.

For details, see “Details of Settings”  (page 95).

3 Click either of the following two buttons to execute the settings.

• Apply: The revisions take effect.

• OK:  The revisions take effect and the Cue Edit window is closed.
 

• To reflect revisions in the Playlist Viewer and OA Playlist applications, you 
should save the story in the iNEWS window. When the focus moves over 
stories in the queue panel, those stories are saved automatically. Otherwise, 
save the story by selecting [File] > [Save Story] from the iNEWS menu bar.

• If an error occurs in saving a story, the Cue Edit window will not be closed. 
The current version of the ELC Plug-in application does not show an error 
message even if the same channel is being used repeatedly or there is an 
insufficient number of DME channels. 

Notes

 Current cue
127Creating a Playlist
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Displaying a Playlist in the Playlist Viewer Application

The Playlist Viewer application allows you to view and check a playlist created 
with the Quick Cue and Cue Edit windows of the ELC Plug-in application. You 
can operate the application independently at different locations simultaneously 
without starting the iNEWS client.

1 Double-click the Playlist Viewer icon (Playlist Viewer) on the Windows 
desktop.
Or, double-click the PlaylistViewer.exe file in the 
“Sony\ELC\PlaylistViewer” folder on the drive where the ELC-MVS01 
software is installed.

The Playlist Viewer starts and the Playlist Viewer window is displayed.

2 Select [File] > [Open] from the menu bar of the Playlist Viewer application.

The dialog box used for selecting a rundown is displayed. Rundowns that 
the iNEWS loads for monitoring are listed in alphabetical order.

3 Select the desired rundown, and click [OK].

The playlist corresponding to the selected rundown is loaded in the Playlist 
Viewer window.
Displaying a Playlist in the Playlist Viewer Application
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You can check the playlist content created in the ELC Plug-in applications. 
In the playlist, the ELC stories are listed. The ELC story consists of the cues 
having the same page number provided by the iNEWS client.  

Note on scrolling of the playlist while on the air
The Playlist Viewer application scrolls the playlist automatically so that the cue 
currently being taken is displayed as the second cue on the screen.
You can view any other part of the playlist at any time, by manually scrolling 
the playlist using the scroll bar and mouse wheel.
Click [Current] in the Playlist Viewer window to reactivate automatic playlist 
scrolling.

 

You cannot start more than the licensed number of copies of Playlist Viewer 
simultaneously.

Exiting the Playlist Viewer  Application

1 Click [File] > [Exit] from the menu bar of the Playlist Viewer.

The Playlist Viewer  application is closed.

Note

Page number Current ELC story

Current button
129Displaying a Playlist in the Playlist Viewer Application
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Chapter8Creating a Playlist for 
ENPS (ELC Plug-in/Playlist Viewer)
Starting the ELC Plug-in Application

The ELC Plug-in application, working as a plug-in  for the existing ENPS client 
software, allows you to create a playlist by using the cues created in the ELC 
Plug-in’s Quick Cue and Cue Edit windows. 

- Editing an item registered in ENPS
- Editing part of a cue in Quick Cue and setting it to ENPS as a new item

1 Start the ENPS client software.

2 Click the rover (green dot) of the Media Control icon on the bottom bar of 
the ENPS client window, and select [ELC Plug-in] from the displayed 
menu. 

The ELC Plug-in application starts and ELC Plug-in window is displayed.

ELC Plug-in window

Media Control icon
Starting the ELC Plug-in Application
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You can start as many ELC Plug-in applications simultaneously on different 
computers as the number of licenses you have.

Exiting the ELC Plug-in Application

1 Click  on the upper right of the ELC Plug-in window.

The ELC Plug-in application is closed.

 

If you do not save the settings, the revisions do not take effect.

Tip

Note
131Starting the ELC Plug-in Application
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Creating a Playlist

This section explains how to create a playlist using the ELC Plug-in application. 
The created playlist will be displayed in the Playlist Viewer application. 

Creating a Playlist

This section explains how to create playlists using cues. Before starting creation 
of a playlist, prepare the cues in the Quick Cue and Cue Edit windows of the 
ELC Plug-in application.

For details on creating cues, see “Creating a Cue”  (page 93). 
For details on setting a cue, see “Details of Settings”  (page 95).

1 Click the Quick Cue tab of the ELC Plug-in window.

The Quick Cue window is displayed.

2 In the rundown in the ENPS client window, double-click the desired ENPS 
story to which you want to add a cue from the ELC Plug-in application.

The script of the selected story is displayed in the editing window of the 
ENPS client window.

Editing 
window 
(script)

Rundown
Creating a Playlist



  C
hapter 8  C

reating a P
laylist for E

N
P

S
 (E

LC
 P

lug-in/P
laylist V

iew
er)
 

Depending on the column you select, the script may not be displayed in the 
editing window. Make sure to display the script. 

3 From the cue folder list of the Quick Cue window, click the folder 
containing the cue that you want to add to a playlist. 

The cues contained in the folder are displayed.

4 Drag the desired cue from the Quick Cue window and drop it on the ENPS 
editing window.

The script of the ELC item is added in the editing window. In the MOS Obj 
Slug column of the rundown, “ELC” followed by the cue name is displayed 
as the item name.

5 Repeat steps 2 through 4 to add cues to the rundown.

To set a new item after checking the content of a cue

You can check the content of a cue and edit it, if necessary, before you actually 
add it to an ENPS story as a new ELC item. 

1 In the rundown on the ENPS client window, double-click the desired ENPS 
story to which you want to add a cue from the ELC Plug-in application.

The script of the selected story is displayed in the editing window of the 
ENPS client window.

2 Double-click on the desired cue in the cue list block of Quick cue.

The Cue Edit window is displayed. The selected cue is loaded into the 
window as the current cue. The registration icon appears on the current cue.

3 Check the content and change the settings, if necessary.

For details, see “Details of Settings”  (page 95).

4 Drag the registration icon from the Cue Edit window and drop it on the  
ENPS editing window (script).

After you save the script, the cue is added as an ELC item to the ENPS 
rundown. In the MOS Obj Slug column of the rundown, “ELC” followed by 
the cue name is displayed as the item name.

Note

4 Registration icon
133Creating a Playlist
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To display added cues in the Playlist Viewer and OA Playlist applications, you 
should save the script in the ENPS window with either of the following operations:
• Press Ctrl + S keys. 
• Select the editing window rover and select [Save] from the menu displayed. 

Rules in setting ELC items
• The ELC items to be included in the same ELC story on a playlist should have 

the same slug. An ELC story consists of ELC items having the same Slug. 
• An ELC item should be placed before the item of the materials that the ELC 

cue uses.
• You can set multiple ELC items in an ENPS story.
• The materials to be used in an ELC cue should be set within the identical 

ENPS story.
• When the Page is set as “Unfreeze page numbers,” it will not be displayed in 

the playlist. To display the page, set “Freeze page numbers.”  

When using multiple PO servers for a single ENPS cue
You should associate the identical PO server icon with multiple video buses or 
audio numbers. You should associate a bus with PO server materials (Ch). 
The ELC Plug-in application uses the ELC items and PO Server settings in the 
order they are assigned in the ENPS story, and associates a video bus or audio 
channel with the materials of the PO Server.

Editing an ELC Item added to an ENPS rundown

You can use Cue Edit to edit a cue that has been added to an ENPS rundown and 
has been described as an ELC item.

1 In the ENPS editing window (script), double-click on the  ELC item that you 
want to edit.

Note

ELC itemENPS editing window (script)
Creating a Playlist
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The selected cue is displayed as the current cue in the Cue Edit window.

2 Make the required settings for the cue.

For details, see “Details of Settings”  (page 95).

3 Click [Apply] to execute the settings. 

• To display added cues in the Playlist Viewer and OA Playlist applications, 
you should save the script in the ENPS window with either of the following 
operations:
- Press Ctrl + S keys. 
- Select the editing window rover and select [Save] from the menu 

displayed.
• The current version of the ELC Plug-in application does not show an error 

message even if the same channel is being used repeatedly or there is an 
insufficient number of DME channels. 

Notes

 Current cue
135Creating a Playlist
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Displaying a Playlist in the Playlist Viewer Application

The Playlist Viewer application allows you to view and check a playlist created 
with the Quick Cue and Cue Edit windows of the ELC Plug-in application. You 
can operate the application independently at different locations simultaneously 
without starting the ENPS client.

1 Double-click the Playlist Viewer icon (Playlist Viewer) on the Windows 
desktop.
Or, double-click the PlaylistViewer.exe file in the 
“Sony\ELC\PlaylistViewer” folder on the drive where the ELC-MVS01 
software is installed.

The Playlist Viewer starts and the Playlist Viewer window is displayed.

2 Select [File] > [Open] from the menu bar of the Playlist Viewer application.

The dialog box used for selecting a rundown is displayed. Rundowns for 
which MOS Control Active is set with ENPS are listed in alphabetical order.

3 Select the desired rundown, and click [OK].

The playlist corresponding to the selected rundown is loaded in the Playlist 
Viewer window.
Displaying a Playlist in the Playlist Viewer Application
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You can check the playlist content created in the ELC Plug-in applications. 
In the playlist, the ELC stories are listed. The ELC story consists of the cues 
having the same slug provided by the ENPS client.  

Note on scrolling of the playlist while on the air
The Playlist Viewer application scrolls the playlist automatically so that the cue 
currently being taken is displayed as the second cue on the screen.
You can view any other part of the playlist at any time, by manually scrolling 
the playlist using the scroll bar and mouse wheel.
Click [Current] in the Playlist Viewer window to reactivate automatic playlist 
scrolling.

 

You cannot start more than the licensed number of copies of Playlist Viewer 
simultaneously.

Exiting the Playlist Viewer  Application

1 Click [File] > [Exit] from the menu bar of the Playlist Viewer.

The Playlist Viewer  application is closed.

Note

Slug Current ELC story

Current button
137Displaying a Playlist in the Playlist Viewer Application
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Chapter9On-Air Operations
This chapter describes on-air operations using the ELC-MVS01 system. The following illustration shows an example im-
age of the sub control room of a news studio.
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Starting the OA Playlist Application

1 Double-click the OAPlaylist icon (ELC OA Playlist) on the Windows 
desktop.
Or, double-click the OAPlaylist.exe file in the “Sony\ELC\OAPlaylist” 
folder on the drive where the ELC-MVS01 software is installed.

The OA Playlist application starts and the OA Playlist window is displayed.

Only one OA Playlist application can be operated in a system at a time. If the 
OA Playlist application has already been operating on the same computer, or on 
a different computer in the system, you cannot start the application.

Exiting the OA Playlist Application

1 Select [File] > [Exit] from the menu bar of the OA Playlist window.

The OA Playlist application is closed.

When you exit the OA Playlist application during on-air operations, a 
confirmation message appears.
Click [OK] to end on-air operation and exit the OA Playlist application. Click 
[Cancel] to continue on-air operation.

Note

Note
139Starting the OA Playlist Application
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Starting/Ending On-Air Operation

The following procedure loads the desired playlist, starts on-air play of that 
playlist, and then ends on-air operation. 

In this section the iNEWS windows are used for explanations. The windows in 
this section may differ from those you will see if you are using ENPS. 

1 First, open a playlist.
In the OA Playlist window, select [File] > [Open] from the menu bar.

The dialog box used for selecting a rundown is displayed. 

2 Select the desired rundown, and click [OK].

The playlist corresponding to the selected rundown is displayed in the OA 
Playlist window. 

For details on the OA Playlist window, see “OA Playlist and Playlist 
Viewer Windows” on page 37.

Tip
Starting/Ending On-Air Operation
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3 Next, start on-air operation.
Press the TAKE button on the shot box module.
Or, select [Playlist] > [Start] from the menu bar in the OA Playlist window.

The system makes the first cue on the playlist ready for on-air play. The 
background of the first cue flashes in yellow.   
Then the yellow background stops flashing, indicating that the cue has 
become the “Next cue.”
The Next monitor shows the image of the cue.

4 Check the image on the Next monitor, and press the TAKE button on the 
shot box module.

The first cue goes on the air. The OA monitor displays the image of the first 
cue. The audio level is automatically adjusted to the one specified for the 
cue.

TAKE button
Shot Box Module
141Starting/Ending On-Air Operation
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• On the playlist
The background color of the first cue turns to green, indicating that the 
cue is now going on the air (OA cue). When the next cue is not ready, the 
second cue flashes in yellow. Then it lights in yellow when it is ready.

• On the shot box module
The TAKE button lights in green during fade in/out of audio and/or a 
transition of video, and then lights in orange.

• On the audio fader panel
The moving faders corresponding to the Audio Icons for the cue move 
automatically, according to the specified audio levels.

5 Repeat step 4 to continue on-air operation.

6 To end on-air operation, select [Playlist] > [End] from the menu bar in the 
OA Playlist window.

The system may not switch audio/video of the current OA cue to the next, 
immediately. That is because some devices, such as a disk recorder, require 
some time (preroll) until a stable video image is output from the device.

Note on scrolling of the playlist during on-air operation
The OA Playlist application scrolls the playlist automatically so that the cue 
currently going on the air is displayed as the second cue on the screen.
You can view any other part of the playlist at any time, by manually scrolling 
the playlist using the scroll bar and mouse wheel.
Click [Current] in the OA Playlist window to reactivate automatic playlist 
scrolling.

Note
Starting/Ending On-Air Operation
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Manual operations available during on-air operation
During on-air operation, the ELC-MVS01 software allows some manual 
operations using the shot box module and audio fader panel.

For details on these manual operations, see 
• “Assigning Functions to the Shot Box Module Buttons” on page 54,
• “Controlling Downstream Keys Manually” on page 146,
• “Controlling the Audio Level Manually” on page 148,
• “Switching Multiple Snapshots Manually (2Box)” on page 152, and
• “Switching Images Manually (Manual Switching)” on page 154.

To close the playlist
In the OA Playlist window, select [File] > [Close] from the menu bar.

The playlist disappears, and the shot box module buttons turn off.
143Starting/Ending On-Air Operation
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Selecting a Cue to be Brought On the Air Next

The OA Playlist application enables you to select a cue to be played next, that 
is, you can change the playout order of the cues on the playlist. This function is 
helpful when a problem occurs with a satellite channel and you have to skip a 
series of cues, for example, or when you have to change the playout order of the 
stories to get some time for quick editing of late-breaking news clips.

In this section the iNEWS windows are used for explanations. The windows in 
this section may differ from those you will see if you are using ENPS. 

1 Double-click the desired cue on the playlist.

The system makes the first cue on the playlist ready for on-air play. The 
background of the first cue flashes in yellow. 
Then the yellow background stops flashing, indicating that the cue has 
become the “Next cue.”
The Next monitor shows the image of the cue.

2 Check the image on the Next monitor, and press the TAKE button on the 
shot box module.

The selected cue goes on the air. The OA monitor displays the image of that 
cue.
On the playlist, the background color of the selected cue turns to green, 
indicating that the cue has become the “OA cue.”  The system gets the 
second cue ready, and the background color of the second cue flashes in 
yellow.

Tip

Double-clicked cue
Selecting a Cue to be Brought On the Air Next
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• When you skip several cues using the procedure described above, you may 
have to change the standby events on the playout server and CG/still store 
system playlists by yourself, as these two are outside the ELC-MVS01 
system. 

• The OA cue, that is, the cue currently on the air, cannot be selected as the Next 
cue.

Notes
145Selecting a Cue to be Brought On the Air Next
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Controlling Downstream Keys Manually

Downstream key operations can be assigned to the buttons on the shot box 
module of the ELC-MVS01 system. The Initial Setup application is used to 
assign functions to the buttons in advance. 
During on-air operations, you can control downstream keys manually by 
pressing the button corresponding to the desired operation. When one of the 
buttons for the DSK 1 - 4 Auto Transition or DSK 1 - 4 Link functions is 
pressed, the transition type and rate currently specified on the switcher (Initial 
Snapshot) are used for transition. 

For details on the Initial Setup operations, see “Assigning Functions to the Shot 
Box Module Buttons” on page 54.

The ELC-MVS01 system does not provide an automatic downstream key 
control function.

1 On the shot box module, select the bank for the button of the desired 
downstream key control operation, by pressing the corresponding bank 
button. 

The buttons to which functions are assigned light in orange or green, 
depending on the functions assigned. The name indicating the function 
assigned is shown on each button.

For details on the functions and colors of the buttons, see “Downstream key 
control functions that can be assigned to the shot box module buttons” 
(next).

2 Press the button corresponding to the desired downstream key control 
operation.

The color of the button you pressed changes, and the downstream key 
control assigned to the button starts.

Note

Shot Box Module
Controlling Downstream Keys Manually
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Downstream key control functions that can be assigned to the shot 
box module buttons
The following downstream key control functions can be assigned to the shot box 
module buttons using the Initial Setup application:

• DSK1 - 4 On/Off
Cuts the downstream key in or out alternately.
The button lights in green when the downstream key is inserted, or orange 
when the downstream key is deleted.

• DSK1- 4 Auto Transition
Inserts or deletes the downstream key alternately, with a transition effect. The 
transition type and rate currently specified on the switcher are used.
The button lights in green during transition, and turns to orange after the 
transition is complete.

• DSK1 - 4 Link
Associates turning the downstream key on and off for the TAKE operation.
The button lights in green when “DSK link” is on, or orange when “DSK link” 
is off. 
When “DSK Link” is not available, the button light turns off, with only 
function name displayed.
When “DSK link” is on, so that the button lights in green, the downstream key 
currently inserted will be deleted upon the next TAKE operation. If the 
downstream key is not inserted now, it will be inserted upon the next TAKE 
operation, with a transition effect. The transition type and rate currently 
specified on the switcher are used.

The names indicated on the buttons may be different from the function names 
described above, as the Initial Setup application enables a technical director to 
name the buttons on the shot box module.

For details, see “Specifying the Name of a Button” on page 56.

Note
147Controlling Downstream Keys Manually
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Controlling the Audio Level Manually

In addition to the automatic fader control function, the OA Playlist application 
enables you to control the audio level, and to turn audio channels on/off 
manually during on-air operation. You can also enable a mix-minus setting for 
certain channels.

For details on the Initial Setup operations, see “Making the Audio Mixer 
Settings” on page 47.

On the audio fader panel, each fader is used to control two channels, so that the 
eight faders can control 16 channels. For example, the leftmost fader controls 
channel 1 and channel B1. Channels 1 to 8 are associated with the Audio Icons 
for automatic fader control, and channels B1 to B8 (back faders) are used for 
manual fader control.
The source buttons located above the faders are used to switch these two. The 
button is green when the channel for automatic fader control (channels 1 to 8) is 
selected, and magenta when the channel for manual fader control (channels B1 
to B8) is selected. 
The name of the channel currently selected appears on the source button.

Use the Initial Setup application to modify associations between the back fader 
numbers (B1 to B8) of the audio fader panel and the devices.
This is helpful in urgent situations, such as when there is breaking news.

Note

Audio Fader Panel

Source buttons
Controlling the Audio Level Manually
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Adjusting the Audio Levels

1 On the audio fader panel, check the name indicated on the source button and 
its color. The source buttons are green when the faders for automatic fader 
control (1 to 8) are selected, while they are magenta when the back faders 
for manual fader control (B1 to B8) are selected.
Press the corresponding source button to toggle the selection, if necessary.

2 Adjust the audio level by using the moving fader for the desired channel.

Once you touch a moving fader for automatic fader control (channel 1 to 8), 
the audio level specified for the cue is cancelled. For example, if you keep 
the moving fader at the –∞ dB position, no audio will be output even when 
the Next cue is taken.

Each source button indicates the audio device name assigned to the channel for 
channels 1 to 8. For channels B1 to B8, the source name imported from the audio 
mixer or the fader number is indicated.

To enable the pre-fader listen (PFL) function
To monitor the pre-fader sound of the audio material, make sure that the LED 
for the function button on the second row is not lit, and hold down the top 
function button for the channel associated with the desired audio device.

Note

Hold down the button for 
the desired channel.

The indicator 
should not be lit.
149Controlling the Audio Level Manually
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Turning an Audio Channel On and Off 

1 On the audio fader panel, check the name indicated on the source button and 
its color. 

The source buttons are green when the faders for automatic fader control (1 
to 8) are selected, while they are magenta when the back faders for manual 
fader control (B1 to B8) are selected.
Press the corresponding source button to toggle the selection, if necessary.

2 Make sure that the LED for the function button on the second row is not lit, 
and press the button on the third row for the desired channel.

Pressing the button alternately turns audio output of the corresponding 
channel on and off.
The LED for the button lights while the channel is turned on. The LED does 
not light when the channel is turned off.

Enabling the Mix-Minus Setting

Using the audio fader panel, you can enable the mix-minus setting for a certain 
channel. When the mix-minus setting is enabled for a channel, sound from that 
channel will be removed from the master audio output upon being sent to a 
certain AUX bus. 
This setting is often used for a reporter at a remote location, so that he/she will 
not hear his/her own voice.
Controlling the Audio Level Manually
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1 On the audio fader panel, check the name indicated on the source button and 
its color. 

The source buttons are green when the faders for automatic fader control (1 
to 8) are selected, while they are magenta when the back faders for manual 
fader control (B1 to B8) are selected.
Press the corresponding source button to toggle the selection, if necessary.

2 Press the function button on the second row for the desired channel, so that 
the LED for the button lights.

This enables the mix-minus setting for the selected channel.

3 Select the AUX bus to which the mix-minus audio should be sent, by 
pressing one of the function buttons.

 
The LED for the pressed button lights, and the mix-minus audio is sent to 
the corresponding AUX bus.

• Depending on the audio mixer you are using, there may be restrictions on 
using the AUX Bus.

• The mix-minus audio is sent to one AUX bus only.
If you select another AUX bus, the mix-minus audio will be sent to the 
newly selected AUX bus and is no longer sent to the old one.

4 When the mix-minus audio becomes unnecessary, press the function button 
on the second row for the channel, so that the LED for the button goes off.

This cancels the mix-minus setting for the selected channel.

AUX bus Button

AUX1 - AUX8 Top function buttons for fader 1 to fader 8.

AUX9 - AUX16 Function buttons on the third row for fader 1 to fader 8.

Notes

 (for AUX1 to AUX8)

 (for AUX9 to AUX16)
151Controlling the Audio Level Manually
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Chapter10Advanced Manual 
Operations
Switching Multiple Snapshots Manually (2Box) 

During on-air operations, you can recall and switch multiple snapshots 
manually. This function is useful when you want to switch to a person at the 
studio and to another at a different location alternately, and also when showing 
both persons in a separate two-panel (2Box) window as shown in the following 
example. 

By allocating three pieces of video material (Snapshots) to three buttons of the 
shot box module, you can easily switch scenes with buttons when the cue is on 
the air.

Required preparations
Before starting operation for multiple snapshots, do the following:
• Assign snapshots to buttons of the shot box module (Initial Setup)
• Create an Effect Icon for manual switching of the snapshots (Icon Manager)
• Set the cue containing the Effect Icon for switching multiple snapshots, and 

add it to the NRCS rundown (ELC  Plug-in)

For details, see “Preparing for Switching Multiple Snapshots Manually 
(2Box)”  (page 108).

1 Start the OA Playlist application and start the on-air operations.

After you completely switch to the video and audio of the assigned cue, all 
the buttons of the groups set with the Icon Manager are enabled and light in 
orange. Among those buttons, the button assigned to the Standby Group 
source materials lights in yellow. 
Switching Multiple Snapshots Manually (2Box)
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2 Press the button on the shot box module to which the desired snapshot is 
assigned. 

You can manually switch among the assigned snapshots and switch cuts by 
pressing the relevant  buttons.

Each time you press the button, the relevant button lights in yellow. 

After the on-air operation of the subject cue is completed, the buttons 
become disabled and turn off.  

Assigned 
buttons on the 
Shot Box 
Module
153Switching Multiple Snapshots Manually (2Box)
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Switching Images Manually (Manual Switching)

During on-air operations, you can switch images at random using the manual 
switching function, while in conventional on-air operations the image transition 
is fixed.
This function is useful when images from multiple cameras have to be switched 
alternately, or when you should switch only one of multiple portions of an 
image. The following examples show how this function is used.

Example 1: A shot is switched from camera 1 to camera 2 within a cue.

Example 2: The image in an inset screen is switched while the rest of the image 
remains in Picture in Picture mode. 

 

Required preparations
Before using manual switching, do the following:
• Assign materials used for manual switching to buttons of the shot box module 

(Initial Setup)
• Create an Effect Icon for manual switching (Icon Manager)
• Set the cue containing the Effect Icon for manual switching, assigning a 

maximum amount of materials to the Icon, and add the cue to the NRCS 
rundown (ELC  Plug-in)

For details, see“Preparing for Manual Switching”  (page 113).

1 Start the OA Playlist application and start the on-air operations.

After you completely switch to the video and audio of the assigned cue, all 
the buttons for the Manual Switching sources set with the Cue Edit window 
are enabled, and all but one light in orange. Among those buttons, the button 
for the standby source lights in yellow. 

2 To switch to the images, press the button on the shot box module to which 
the desired materials are assigned. 

Camera 1 shot                                       Camera 2 shot 

While showing an image from a news studio, only the images in the 
background insert screen switch.
Switching Images Manually (Manual Switching)
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You can manually switch among the assigned materials by pressing the 
relevant  buttons.

Each time you press the button, the relevant button lights in yellow.  

After the on-air operation of the subject cue is completed, the buttons 
become disabled and turn off. 

The audio will not be switched.

Note

Assigned 
buttons on the 
Shot Box 
Module
155Switching Images Manually (Manual Switching)
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Glossary

Audio Fader Panel
The JL Cooper fader panel, which 
allows you to register audio input 
controlled by the ELC-MVS01. 
The following features are available:
• Display and adjustment of audio 

level with the Auto Fader feature
• MIX- setting
• Channel On/Off
• PFL (Pre Fader Listening) setting 

(Cue)

Audio Icon
An Audio Icon represents audio 
materials from an audio or video 
server. It is used to change audio 
materials.

Audio Server
A server that saves and plays audio 
files. An audio server does not have 
playlist function.

Auto Transition 
A function assigned to a button on the 
shot box module. Pressing the Auto 
Transition button starts the DSK 
transition. 

BKGD/ALL
A transition setting that allows you to 
select whether only a background 
image (A bus) among the images 
composing a cue is transitioned or the 
whole image of a cue is transitioned 
to the next cue.

CG (Character Generater)
The device that generates and plays 
characters or images. A server having 
a playlist function. The CG/Still 
Store controller type with a playlist 
function and a storage type without a 
playlist function can be a different 
device.

Class
A categorization of an Icon. 
According to the class selected, the 
menus show relevant options for the 
class.

Continuous
A function to be used when you 
continuously use the same material 
both in a cue currently on the air and 
a cue to be on the air next.  Usually, 
when the same material is set in two 
consecutive cues, functions such as 
Play, Shot Recall of Camera, etc., 
will operate again from the beginning 
with the TAKE operation. To use the 
same material without repeating 
those operations, the  icon is used. 
Set with a Video or Audio Icon of the  
class. Since it is supplied by the 
system, it is not necessary to create 
this type of Icon.

Cue
The minimum unit that can be put on 
the air by using the TAKE button. A 
cue, a frequently-used scene, is 
composed of Icons and their detailed 
settings. 

Cue to be brought on the air 
next
Assigning a random cue to be used on 
the air next. To change the order of 
programs or skip a cue, you can 
change the order of TAKE operations 
from the OA Playlist. When you 
change the order from that of the OA 
playlist, note that synchronization 
with the CG, playout server, or other 
device may fail.  

Cue Edit
The tool used to edit an ELC cue  in  
the ELC Plug-in window. 
You can add, delete, or change 
components of a cue, and create a 
playlist.

Current Button
The button used to instantly display 
the cue currently on the air while 
scrolling the playlist manually.

Current Cue
The cue currently being edited, 
appearing at the top of the Cue Edit 
window.

DDR (SonyVTR)
A disk recorder that the ELC-MVS01 
can control via the Sony VTR 
Protocol. 
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DDR (VDCP)
A disk recorder that the ELC-MVS01 
can control via the VDCP (Video 
Disk Control Protocol). It contains 
daily-use video files. To use files in 
the ELC-MVS01 system, you should 
register the required files in a file list 
in advance. This recorder does not 
have a playlist function.

DSK (Downstream Key)
The key to be inserted in the last 
program output. By using buttons on 
the shot box module with the function 
assigned, you can insert or delete  the 
key. To synchronize the DSK with a 
TAKE operation, use the DSK Link 
function and perform a TAKE 
operation.

DSK Link
Inserting and deleting the DSK 
simultaneously with a TAKE 
operation according to the switcher 
settings. To perform this operation, 
use a button on the shot box module 
to which the function is assigned.

Effect Icon
An Effect Icon represents video 
effect settings. The status of the video 
switcher is registered as a “snapshot” 
in the switcher and recalled to be 
used in the Effect Icon. This is used 
to set a video effect. By switching 
multiple snapshots, you can create a 
dynamic image effect. An effect Icon 
contains a Video Icon as an element.  
Create an Effect Icon after the Video 
Icon is created.

ELC Object
A cue dragged from the ELC Plug-in 
to an NRCS rundown, which is called 
“ELC Production cue” for iNEWS 
and “ELC Item” for ENPS.

ELC Plug-in
Plug-in software that the ELC-
MVS01 supplies for users to create 
an ELC playlist. It works as part of 
the NRCS client window.

ELC Story
A group of cues. 
If you are using iNEWS, cues having 
the same page number in the iNEWS 
rundown make a group.
If you are using ENPS, cues having 
the same slug in the ENPS rundown 
make a group.

ENPS
The News Room Computer System 
(NRCS) supplied by Associated 
Press.

ENPS Story
A line of an ENPS rundown.

Icon
A graphic representing settings of a 
video switcher, audio mixer, or 
devices for materials including 
cameras, servers, and CG. It is used 
to create and edit a cue. The ELC-
MVS01 provides Video, Audio, 
Transition, and Effect Icons. 

iNEWS
The News Room Computer System 
(NRCS) supplied by Avid 
Technology, Inc. 

iNEWS Story
A line of an iNEWS rundown.

Initial Setup
An ELC-MVS01 application that is 
used to perform setup for daily-
operations.

Initial Snapshot
A snapshot used to initialize the 
Video Switcher for on-air operations, 
or to contain the settings made for the 
system. Users can select at random 
from Snapshots 1 to 99 of the System 
Setup application.

Key Memory
A function of the video switcher that 
allows the key settings to be stored 
automatically according to the pair 
number, so that the next time the 
same pair number is selected, these 
settings are recalled automatically. 

Manual Switching
Function used to switch scenes at 
random, manually. You can register 
up to 6 video signals in the shot box 
module, and switch scenes by 
pressing the buttons on the shot box 
module. This function is assigned to 
an Effect Icon.

NEXT M/E
The M/E bank used for the NEXT 
Cue in the video switcher. 

OA M/E
The M/E bank used for the OA Cue in 
the video switcher. 

Pair No.
The combination expressed as a 
number of video signal and key 
signal assigned to a cross point. It is 
set by the video switcher.

Playlist
A list used to play each piece of 
material in order, created based on 
the rundown received from the 
NRCS. A server under the ELC 
control does not contain a playlist 
function, but the CG and playout 
server have their own playlists.

Playlist Viewer
The Playlist Viewer allows you to 
view playlists created with the ELC 
Plug-in application. (The software 
works as an application independent 
of the ELC Plug-in application.) 
While the ELC Plug-in application 
allows you to view only one cue, the 
Playlist Viewer application allows 
you to view the whole program 
structure. 
Glossary



 A
ppendix
PO (Playout) Server
A playout server is a server having a 
playlist function. It handles daily-
changing materials. The controller 
containing a playlist function and the 
storage without a playlist function 
can be a different device. 

Program End
Ending an on-air operation.

Program Start
Starting an on-air operation.

Quick Cue
The tool used o create a playlist 
easily in  the ELC Plug-in window. 
You can register frequently-used 
device settings as a cue and use it in 
creating a playlist. This allows you to 
create, delete, rename, and sort cues. 
You can also move cues between 
folders, and manage folders.

Robotic Camera
The camera system that allows you to 
control PTZE (Pan-Tilt-Zoom-
Elevation) of cameras from a remote 
site. You can register the camera 
settings as a Shot in advance, and 
recall the shot later.

Shot
Function used to save a PTZE (Pan-
Tilt-Zoom-Elevation) or other status 
set by a camera, recall it and 
reproduce the same status. 
 

Shot Box Module
The MKS-8033A Utility/Shot Box 
Module for the Sony MVS-8000 
Multi Format Switcher system. The 
shot box module is used for 
allocating a variety of manual 
operations while on the air, including 
TAKE operation, or insertion or 
deletion of the DSK. 

Snapshot
The function to save a status set by 
the video switcher in the switcher 
memory, recall it and reproduce the 
same status. It has 99 registers for 
each region, block classified 
according to functions.

TAKE
Progressing on-air operation to the 
next cue on the playlist, making the 
NEXT Cue the OA Cue.

Transition Icon
A Transition Icon represents a video 
transition setting. Various video 
transition settings are registered as a 
“snapshot” in the switcher, and the 
Transition Icon represents the 
snapshot.  It is used to make the 
transition from one cue to the next 
one.

Video Icon
A Video Icon represents video 
materials of cameras, video servers, 
CG, and DDR. It is used to change 
video materials.

V/K
Video signal and Key signal.
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